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 Abstract 

Engineering Application-Specific Plasmonic Nanoparticles: Quantitative Measurements 
and Precise Characterization 

by  

Lindsey Anderson 

Nobel metal nanoparticles that exhibit plasmon resonances in the visible and near 

infrared have been of great interest in recent years. Strong light-matter interactions on the 

nanoscale have a range of interesting properties that may be useful in applications in 

medicine, sensing, solar energy harvesting and information processing. Depending on the 

application, particle materials and geometries can be optimized for performance. A novel 

method of quantifying individual nanoparticle scattering cross sections by comparing 

experiments with analytical theory for gold nanospheres is proposed and utilized. Results 

show that elongated particles scatter very brightly for their volumes. This brightness is 

due to a strong longitudinal plasmon resonance that occurs in the near infrared – where 

gold has minimal loss. Elongated particles, such as nanorods, are therefore ideal for 

applications that rely on particles scattering brightly from small spaces, such as biological 

imaging.   

Next, gold nanobelts are discussed and characterized. These novel structures are 

akin to nanowires, but with a small, rectangular cross-sectional geometry. Gold nanobelts 

are shown to exhibit a strong transverse resonance that has never been reported 

previously in nanowires. The transverse resonance shifts linearly with cross-sectional 

aspect ratio. Other interesting products from the nanobelt synthesis, tapered and split 

nanobelts, are discussed.  Gold nanobelts also support longitudinal propagating plasmons, 



 ii 

 

  

and have the smallest cross-sectional area of any elongated plasmonic structure that has 

been reported to do so. By analyzing the output tip signal of propagating plasmons for 

nanobelts of different lengths, the decay length is measured. Finite Difference Time 

Domain simulations and polarization measurements show the fundamental, azimuthally 

symmetric mode is very strong for thin structures such as these, but decays much more 

quickly than a higher-order mode, which begins to dominate at longer lengths. The cross-

sectional mode area is given, illustrating the high confinement of plasmons in these 

structures. A figure of merit that takes into account both confinement and propagation 

length is calculated to be 1300 for the higher-order mode, the highest reported for 

nanoscale plasmonic waveguides. The high figure of merit makes gold nanobelts 

excellent candidates for studying strong coupling between plasmonic structures and 

objects that exhibit quantum behavior.   
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1 Introduction 
 

Plasmons polaritons are collective oscillations of the free electron gas density in a 

metal. The oscillating field of electromagnetic radiation excites plasmon modes which 

then propagate on the metal surface. Classically, the electrons can be thought of as an 

incompressible fluid and the SPR likened to a wave on this fluid. In this analogy, the 

incident light can be thought of as a “rock” hitting a “pond” of electrons, causing surface 

waves. Under certain excitation conditions one gets a strong coupling known as surface 

plasmon resonance (SPR). For metal particles on the order of or much smaller than the 

wavelength of incident light, a special, highly localized type of plasmon resonance 

occurs. Due to the small size of the metal particle compared with the wavelength of the 

light, the particle is effectively seeing the same electric field throughout its volume at any 

given time. The free electrons in the particle then collectively oscillate in what is termed a 

localized surface plasmon resonance (LSPR). On resonance, the extremely high 

confinement of the electromagnetic energy in and around the nanoparticle results in 

bright scattering, strong absorption, and intense electric field enhancements. 1-3 

Noble metal nanoparticles and nanostructures exhibit LSPR at visible and near-

infrared frequencies. Over the past decade, a wide variety of plasmonic gold and silver 

structures have been fabricated through “bottom-up” chemical methods. 1, 4, 5 Their 

physical properties have generated great interest in these materials for applications in 

biomedical therapies and diagnostics.6-8 Bright resonant scattering is useful for 

microscopic imaging contrast and microscopic particle tracking.9, 10 Nanoparticles with 

sharp tips and gaps between nanoparticles create regions of highly enhanced 
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electromagnetic fields which amplify vibrational spectroscopies for sensing 

applications.11, 12 Plasmonic nanoparticles can be coupled to fluorescent dyes or quantum 

dots to manipulate radiative decay rates and directions, thus fundamentally manipulating 

optical emission.13, 14 All of these applications rely to some extent on the ability to tune 

nanoparticle plasmon resonances to match a biological window of tissue transparency, to 

coincide with an emitter excitation, or simply to match a laser source.  The capability to 

tune the plasmon resonance has played a crucial role in stimulating the current interest in 

plasmonics. 

Nanoparticle plasmon resonances can be characterized by a number of techniques, 

including ensemble spectral extinction measurements,15 single particle spectral scattering 

measurements,16-26 near field optical microscopy,27, 28 electron energy loss 

spectroscopies,29, 30 and cathodoluminsecence.31, 32  Single nanoparticle studies are 

particularly powerful for characterizing plasmon resonances since they avoid the 

confounding effect of nanoparticle heterogeneity.  They are often carried out by dark 

field microspectroscopy at high numerical aperture (>0.5), and have been applied to a 

variety of complex nanoparticle shapes for fundamental studies of the nature of the 

plasmon resonance.16-23, 25  

For extended structures, surface plasmons propagate along the metal surface at the 

frequency of the incoming light, but with shorter wavelength. This plasmon propagation 

phenomenon may be used to transport optical information. 1, 6, 33-36 For example, light can 

be coupled into surface plasmons in a two-dimensional film through a defect, and its 

propagation can be manipulated by nanostructures within the film.37-39 Recently there has 

been interest in plasmon propagation in one-dimensional plasmonic nanowires.40-45 Long-
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range plasmons can have propagation lengths of several microns in gold and silver for 

visible and NIR incident wavelengths.46 Here light can be coupled into and out of the 

nanowires through symmetry broken sites such as tips, kinks, or nanoparticle-nanowire 

junctions, creating a plasmonic waveguide.47-49 The coupling between propagating 

nanowire plasmons and nearby quantum dots could enable the integration of plasmonic 

structures into nanometer scale optoelectronic devices.50-55 Nanowire propagating 

plasmon modes have been studied largely with silver nanowires that have cross sections 

of 75 – 260 nm in diameter.42, 43, 47, 56 While these efficiently couple, transport, and emit 

light, their large size leads to transport based on a mixture of higher order plasmonic 

modes and may limit the strength of interactions with nearby emitters and other 

plasmonic structures.57  

The work here focuses on the precise characterization of both the optical and 

geometrical properties of structures on the nano- and mirco-scale. Plasmonic 

nanoparticles are known for their intense scattering, which is visible in dark field 

microscopy, where count rates are measured with a charge-coupled device (CCD). A 

quantitative measure of scattering for spherical particles can be given as an effective 

cross-sectional area by the Mie Solution. There is not, however, an analytical solution for 

the scattering cross sections of nanoparticles of complex shapes. Chapter 2 outlines 

theory and experiments dealing with the quantification of single nanoparticle LSPR 

scattering cross sections. By comparing spherical particle scattering to the Mie Solution, 

a constant relating dark field scattering CCD count rates to the scattering cross section is 

obtained. This constant is then applied to gold nanorods and bipyramids and a 

quantitative comparison of nanoparticle scattering is given. The purpose of this work is to 
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optimize particle shapes that are used in applications that require particles that scatter 

brightly. In chapter 3, a new class of elongated plasmonic nanostructures is introduced: 

gold nanobelts. These structures exhibit bright, narrow plasmon resonances across their 

width and often change color along their length – containing many colorful resonances in 

a single structure. Most nanowires studied to date are too large in diameter to exhibit 

these narrow, localized plasmon resonances. Gold nanobelts also support propagating 

surface plasmon modes and have the smallest measured cross-sectional area of any 

elongated structures that have been reported to do so. Gold nanobelts are very interesting 

because they are the first reported single structure that supports both a localized 

transverse plasmon mode and two detectable long-range propagating plasmon modes. 

The properties of these types of plasmon modes are explored and discussed. Due to their 

small size, gold nanobelts display a high level of plasmon confinement, making them 

interesting for applications involving strong coupling between plasmons and quantum 

objects. 
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2 Quantifying Gold Nanoparticle Scattering Cross Sections 

2.1 Background and Theory 
 

If one imagines the electron density along a line around the circumference of the 

surface of a small, spherical particle, the fundamental plasmon mode would have two 

peaks: one positive and one negative, as shown in Figure 1. For higher order modes, 

which are very weak for increasing small particle size, the number of electron surface 

density peaks will increase. As particle size increases, higher order modes become 

stronger - with the total number of peaks increasing as powers of two. The asymmetry of 

mode orders that are not powers of two make those mode orders energetically 

unfavorable. 

             

Figure 1 Electron surface charge density of a spherical nanoparticle with a dipolar (top) and quadrupolar 
(bottom) plasmon resonance.  

 

The total amount of incident light that a nanoparticle either scatters or absorbs is 

referred to as the extinction (Figure 2). In other words, extinction quantifies how much 

light the particle “took out of” the incident wave. The amount a given particle scatters or 

absorbs at a given wavelength is quantified by a cross section. Nobel metal nanoparticles 
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exhibit a resonance in the visible/NIR, meaning there is a sharp distribution of 

wavelengths that interact strongly with the particle in that energy region. Cross sections 

are measured in the same units as a spatial area (m2, for example), but gives an effective 

cross-sectional area for that particle as far as its scattering or absorption properties are 

concerned. 

 

 

Figure 2 Schematic of an electromagnetic wave incident on a small gold sphere. Some of the incident 
radiation is absorbed by the particle, some is scattered, and the remainder continues traveling in the k-
direction. 
  

For sub-wavelength sized nanoparticles, the off-resonant optical extinction cross 

section is smaller than the cross section of the particle itself due to diffraction (Figure 3a). 

On resonance, however, the extinction cross section can be larger than the physical cross 

section (Figure 3b). The dashed line in Figure 3b is the effective size of the particle when 

on resonance. 58  

              

E 

B 

k 
nanosphere 

Incident plane 
wave 

σsc   +   σabs   =   σext 
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Figure 3 Field lines of the total Poynting vector (excluding the scattered) around a small aluminum sphere 
illuminated a) off resonance and b) on resonance. The dashed line in b indicates the effective absorption 
radius of the sphere. 

 
                                     

While previous studies of single particle spectra have been well suited to 

measuring the resonant wavelength and spectral width, there are few reports on the 

precise experimental characterization of the amplitude of the resonance, which 

corresponds to the cross section.59, 60 Such characterization could be valuable for 

determining nanoparticle concentrations, predicting heat generation and scattering 

signals, testing the accuracy of numerical simulations, and possibly evaluating near field 

enhancements.61, 62 For intracellular imaging applications, particles need to be small 

enough to penetrate the cell wall, yet scatter a sufficient amount of detectable light. By 

quantifying the scattering cross section of different shaped nanoparticles, it will be 

possible to make particle choices that are application specific. 

In their seminal paper, Schultz et al used single silver nanoparticles as specific 

biological labels for microscopic imaging, and estimated a single nanoparticle to provide 

approximately 106 more signal than a fluorescein molecule and approximately 105 more 

signal than a quantum dot.63  The past decade has seen major advances in the synthesis of 

gold and silver nanoparticles with complex shapes and sizes that have also been 

considered for biological labeling. However, the measurements and estimates quoted 

a b 
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above were for an 80 nm diameter silver nanoparticle, and the scattering signal from 

other plasmon resonant nanoparticles varies widely.  The scattering cross section is 

strongly dependent on the nanoparticle size and shape,64 the spectral variation of the 

metal dielectric properties, and the refractive index of the medium.  In fact, the peak total 

scattering cross section for gold and silver nanospheres between 10 and 100 nm 

diameters varies over five orders of magnitude Figure 4. 

 

  
Figure 4 The total scattering cross section for gold nanospheres in a medium of refractive index 1.515. 

 

The scattering signal collected in imaging applications will depend on the 

illumination angle and differential scattering cross section integrated over the solid angle 

of the imaging lens, so predictions based on the total scattering cross section can be 

misleading. While there have been some numerical simulations of the effect of 

nanoparticle size and shape on the magnitude of the scattering cross section,65-67 the lack 

of direct experimental comparison has left plasmon resonant nanoparticles’ scattering 

Sphere Diameter 
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properties ambiguous and at times perhaps even overstated. Here, an effort is presented to 

quantify the scattering from plasmon resonant nanoparticles with complex shapes by dark 

field microspectroscopy. 

2.1.1 Scattering Cross section of a Sphere (Mie Solution)  

 

The problem of scattering from a sphere due to an incident plane wave can be 

solved analytically. Following Bohren and Huffman,58 a realizable time-harmonic 

electromagnetic field in a linear, isotropic, homogeneous medium must satisfy the wave 

equation: 

0EE 2 =+∇ k2  0HH 2 =+∇ k2  

where k2=ω2εµ, and have no divergence:  

0E =⋅∇   0H =⋅∇  

Additionally, E and H are not independent:  

HE ωµi=×∇   EH ωεi−=×∇  

Vector functions that satisfy these requirements can be constructed: 

)( ϕcM ×∇=   
k
MN ×∇

=  

where φ is a scalar function and c is an arbitrary constant. M and N have all of the 

required properties of an electromagnetic field: they satisfy the vector wave equation, 

they are divergence free, and the curl of one is proportional to the other.  Furthermore, it 

can be shown that if M satisfies the vector wave equation, φ satisfies the scalar wave 

equation. Therefore, the problem of finding solutions to the field equations reduces to the 

simpler problem of finding solutions to the scalar wave equation (for φ). φ is termed the 

generating function for the vector harmonics M and N and c is called the guiding or pilot 
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vector. Due to the spherical symmetry of the problem, functions φ that satisfy the wave 

equation in spherical coordinates are chosen and c is chosen to be the radius vector r.  

 In spherical coordinates, φ is of the form: 

)()()(),,( φθφθϕ ΦΘ=   rRr  

Inserting this into the wave equation in spherical coordinates, the result is 3 separated 

equations: 

d 2Φ
dϕ 2 +m

2Φ = 0      (1) 

                         

1
sinθ

d
dθ

sinθ dΘ
dθ

"

#
$

%

&
'+ n(n+1)− m2

sin2θ
)

*
+

,

-
.Θ = 0     (2) 

 

               
d
dr

r2 dR
dr

!

"
#

$

%
&+ k2r2 − n(n+1)() *+R = 0             (3) 

            

 

where m and n are integers. For Φ , the linearly independent solutions are φme cos=Φ  

and φmo sin=Φ . Solutions to (2) are the associated Legendre functions of the first kind 

)(cosθm
nP of degree n and order m (n = m, m+1,…). The Legendre functions ultimately 

give the angular dependence of the scattering cross section. Finally, the linearly 

independent solutions to (3) are the spherical Bessel functions or the first and second 

kind. By plugging these solutions into M and N, Memn, Momn, Nemn and Nomn are obtained. 

The scattering fields can be expressed as linear combinations of these vector spherical 

harmonics. Due to orthogonality, only Legendre functions of the first order are nonzero. 

The incident plane wave is expressed in spherical coordinates as  



 11 

 

  

 ∑
∞

=

−
+
+

=
1

)1(
1

)1(
1 )(

)1(
12

n
neno

n
i i

nn
ni NMEE 0  ∑

∞

=

−
+
+−

=
1

)1(
1

)1(
10 )(

)1(
12

n
none

n
i i

nn
niEk NMH

ωµ
 

After imposing particle boundary conditions and the orthogonality of the vector 

harmonics, an expression for the scattered fields is given as: 
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m is the relative refractive index (m = np/nm), np is the complex refractive index of the 

nanoparticle material, nm is the refractive index of the medium, x=kr where r is the 

nanoparticle radius, and ψn  and ξn  are the Riccati-Bessel functions. The incident and 

scattered fields in each polarization state can be related by the amplitude scattering 

matrix as follows: 
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where the incident plane wave is traveling in the z-direction. Writing this equation in a 

different way, it is possible to relate the intensity and polarization of the incident and 

scattered waves.  
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The elements of the scattering matrix are known as the Stokes parameters. Our 

experiments are done with unpolarized light, for which the state vector is (1 0 0 0), so the 

Stokes parameter ( )222
111 2

1 SS
I
IS
i

s +==
 
are of interest, where I is simply the irradiance. 

Differential cross sections are of interest since they are experimentally relevant: 

11
2Sr

d
d sc =
Ω
σ . The scattering parameters S1 and S2 incorporate the angular functions 

defined as πn = P1
n/sinθ and τn = dP1

n/dθ where θ is the polar angle of the scattered light 

relative to the incoming wave vector,  
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Using these expressions, the differential scattering cross section is: 

            
(6) 

                  

where km is the wavenumber of the light in the surrounding medium (km=2πnm/λ), an and 

bn are given in (4) and (5), and λ is the vacuum wavelength. The sums over n are over all 

multipole excitations. The total scattering cross section is expressed as: 
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σ sc =
2π
k2

(2n+1)
n=1

∞

∑ an
2
+ bn

2( )           (7) 

      

A MATLAB program was written to calculate the differential and total scattering 

cross sections of spherical particles of a chosen material in a defined dielectric medium 

(Appendix A). Polar plots of the angular scattered irradiance for a water droplet in air 

show the expected dipole for small particles (Figure 5) for light polarized parallel (red) 

and perpendicular (green) to the scattering plane. As particle size increases, however, a 

larger fraction of the total scattering is in the same direction as the incident light (forward 

scattering). With the incoming light is along 0º, the plots in Figure 6 show the angular 

scattering pattern for increasing water droplet size.  The black plots (left) are taken 

directly from Bohren & Huffman and the colored plots (right) were made to verify the 

calculations. These plots illustrate the importance of accounting for the size and angle of 

the objective when comparing dark field measurements with calculations, i.e. it is not 

safe to assume that the same fraction of scattered light is being measured for different 

particles. Furthermore, the scattering patterns are most likely much more complex for 

nonspherical particles. 
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Figure 6 Angular scattering irradiance of a spherical water droplet where x=2πnpr/λ. Forward scattering 
increases as the ratio of the particle size increases. Parallel (dashed and red lines) and perpendicular (solid 
and green lines) polarization of incident light. 
  

Figure 5 Dipolar scattering pattern for a spherical water droplet in the small particle limit for light 
polarized parallel (red) and perpendicular (green) to the scattering plane.          
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2.2 Approximations and Extensions to the Mie Solution 
 

The total cross section expressions from the Mie solution can be simplified by 

assuming particles that are much smaller than the wavelength of the incident light. 

Sometimes referred to as “the dipole approximation”, the small particle approximation 

not only omits all but the n = 1 term in Equation 5 (dipole term), but also assumes that (kr 

<< 1). In this case, only the first few terms in the power series expansions of the spherical 

Bessel functions are significant. The Mie solution for the total scattering cross section 

reduces to: 
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where V is the nanoparticle volume, εm is the dielectric function of the medium, and ε1 + 

iε2 is the complex dielectric function of the nanoparticle. Note that complex refractive 

indices are often used to express the full Mie solution, but approximations for small 

particles are most succinctly written with the corresponding dielectric functions. 

The Mie solution can be extended to spheroids in this small particle limit, yielding 

the following expression, known as the Gans Solution: 
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where Pj are depolarization factors which depend on the nanoparticle aspect ratio.68   
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size range over which such approximations are accurate, Figure 7 displays the total 

scattering cross section calculated by Equation 5 (full Mie solution) and Equation 6 

(small particle approximation) for 10, 60, and 100 nm diameter gold nanospheres.  The 

MATLAB program in Appendix B was used for all calculations in this section. The small 

particle approximation is quite accurate for the 10 nm diameter nanosphere, it is blue-

shifted but of similar magnitude for the 60 nm sphere, and it is completely inaccurate for 

the 100 nm sphere. 

  

Figure 7 The total scattering cross sections for gold nanospheres of diameter 10nm, 60nm, and 100nm in 
oil calculated by the full Mie solution (blue) and the small particle approximation (orange).  

 

a 

c 

b 

10nm Sphere 

60nm Sphere 

100nm Sphere 
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It should be noted that referring to Equation 6 or a similar expression for the 

extinction as “the dipole approximation” is a bit of a misnomer. If the scattering cross 

section is calculated using only the dipole term (Equation 4, n=1), the calculations agree 

with the full Mie expression (summing over all multipole terms) for spheres larger than 

100nm (Figure 8).  It is the small particle approximation which simplifies the expression, 

and which makes the solution valid only for particles below 100 nm diameter. 

  

  

Figure 8 Scattering cross sections for gold nanospheres of diameter 10nm, 60nm, and 100nm in oil. The 
dipole term only (green) agrees well with the full Mie expression (red). 
 

 

Full electromagnetic solutions for scattering from spheroids which could yield the 

differential scattering cross section for elongated nanoparticles have been derived,69 but 

they have not yet been applied to nanoparticle plasmon resonances. Numerical 

simulations are certainly the most straightforward approach to predicting the brightness 
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of a specific nanoparticle of arbitrary shape.  Several numerical methods have been 

employed to calculate the scattering properties of non-spherical particles, including Finite 

Element Method, Boundary Element Method, Finite Difference Time Domian, T-Matrix 

and Discrete Dipole Approximation, but they typically report the total cross section,65-67, 

70, 71 so they cannot be directly compared to the results presented here.  Recently, 

numerical simulations have been reported which exactly match dark field measurements 

of nanoparticles on substrates.72  If such simulations were designed to also report 

scattering cross sections, they could be quantitatively compared to the experimental 

observations described here.  

     As shown above, the Mie solution including angular dependence is the only 

analytical solution applicable to the problem of single particle scattering in the dark field 

geometry for particles in the 50-100nm range. Therefore, this solution can be used to 

calibrate dark field measurements with spheres to obtain the scaling constant between the 

scattering cross section at the angle of the objective and the CCD counts per second. 

After finding this constant for a specific microscope system, the constant can be used to 

find the scattering cross section at the angle of the objective of arbitrarily shaped 

particles. 
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2.3 Dark field Microscopy 
 

The epi-illuminated dark field imaging geometry is illustrated in Figure 9. The 

illumination is directed to the sample from an annular ring around the objective lens.  For 

an optically flat substrate, only light scattered from the nanoparticle enters the objective 

while the remainder of the light passes through the glass. If one assumes constant 

incident irradiance Einc, to the nanoparticle, then the scattered radiant power that enters 

the objective, Φsca, will be proportional to the nanoparticle differential scattering cross 

section integrated over the solid area of the objective lens.   

 

 

Figure 9 Schematics of the dark field imaging and scattering geometries. 

 

This integrated value of the differential cross section will be referred to as σobj.  

When the scattered light reaches the CCD, it will generate a count rate that is 

proportional to Φsca, and therefore proportional to σobj. For the dark field microscope 

a b 
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objective used here (Zeiss LD Epi-plan 50x/0.5), the angle between the annular 

illumination and the optical axis of the objective lens is 45 degrees, and the numerical 

aperture of the objective indicates that light is collected into a 30 degree cone.  The 

corresponding scattering diagram is shown in Figure 9b.  If the optical axis is now taken 

to be along the incident illumination direction, one sees that the differential scattering 

cross section measured is backscattering approximately 225 degrees from the incident 

direction.   

To achieve experimental conditions that match Mie scattering theory (see Figure 

9a), nanoparticles were deposited onto glass substrates and covered with index matching 

oil and a cover slip so that the nanoparticles were in a homogenous dielectric medium 

rather than at a dielectric air-glass interface. The objective lens is not designed for oil 

immersion, but since it has a long working distance (6.7mm), it images well through the 

thin cover slip and oil layer (0.2 mm).  The air-glass dielectric interface, although now 

separated from the nanoparticle, will affect the incidence and scattering angles.  By 

approximating the imaging system with geometrical optics, the scattering angle θ was 

calculated to be 207 degrees. Since the illumination and light collection occur around the 

optical axis of the objective, the CCD signal is proportional to the azimuthally-averaged 

differential section around σobj, as illustrated in Figure 9b.  For a nanoparticle with 

azimuthal symmetry (such as a nanosphere), this azimuthal dependence can be ignored.   
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2.4 Methods 

2.4.1 Sample preparation 

 

Gold nanospheres (Ted Pella) were deposited sparsely on a glass substrate. Figure 

10a shows a schematic of the particles face-down (the dark field illumination and 

detection below the substrate). In order to correctly characterize each particle the location 

needed to be verified.  An indexed TEM grid was placed on top of the particle side, then 

chrome and gold were evaporated onto the slide. After removal of the TEM grid, bare 

glass with particles is left in the previously covered areas (Figure 10b).  Individual, 

isolated gold nanospheres were found and confirmed by correlated atomic force 

microscopy (AFM) and dark field imaging. Before measuring the single particle 

spectrum, index-matched oil was dropped on the slide, covered with a cover slip and 

sealed (Figure 10c).  

 

 
 

Figure 10 Schematic of reference grid evaporation process and oil immersion. 
 

 

 Following oil immersion, the spectrum of individual particles was measured with 

the dark field microspectrometer. Figure 11 shows the dark field image of a single 
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particle on glass within the indexed TEM grid. The particles were isolated in a horizontal 

slit, then the mirror reflecting light into the CCD was changed to a diffraction grating in 

order to measure the particle spectrum. 

 

 

Figure 11 A dark field image of the particle substrate with the index grid. The green point is a single gold 
nanoparticle. 

 

 

2.4.2 Data analysis 

 

An example of a CCD image using the diffraction grating is shown in Figure 12. 

The bright line near the center of the image is the image of a single gold nanosphere 

isolated in a horizontal slit. The vertical axis is the wavelength of the scattered light, the 

horizontal axis is the position along the slit and the color intensity reveals the scattering 

intensity at that respective wavelength and position. The bright objects near the edges are 

due to the scattering of the alignment marks.  
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Figure 12 CCD image capturing a single nanoparticle spectrum. 

 

These images were processed in MATLAB (Appendix C) in order to obtain a 

spectrum. Based on the image, the data analysis program asks the user to specify the 

particle position and width in pixels over which it sums the intensity. The background 

near the particle is fit to a polynomial of an order specified by the user and is subtracted 

from the particle signal. The result after the user enters the integration time of the image 

is the CCD counts per second as a function of the wavelength. Figure 13a displays the 

dark field spectral scattering rate for nanospheres that are 79 nm and 109 nm in diameter 

with the AFM images inset. For calibration, the differential scattering cross sections of 

the spheres were calculated from Mie scattering theory. The calculations included the 

first ten terms, and were integrated over the solid angle of the microscope objective to 

find σobj.  The resulting cross sections are plotted in Figure 13b.  The relative spectral 

magnitudes of the count rates and Mie calculations match quite well.  Figure 13c displays 

the spectral “scattering constant” for the dark field microspectrometer, Kλ, found by 

dividing the count rate by σobj at each wavelength.  Error bars, determined from the 

~175nm 

~1000nm 

Wavelength 
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experimental CCD counts in Figure 13a, are included. Since Kλ is simply a calibrated 

spectral efficiency of the dark field microspectrometer and independent of the sample, the 

79 and 109 nm diameter nanoparticles yield similar curves (Figure 13c). Kλ can therefore 

be used to convert CCD count rates to cross sections for other nanoparticle shapes. 

Measurements on nanorods and bipyramids were analyzed with an average of the two 

curves presented in Figure 13c. 

 

Figure 13 Calibration of the dark field scattering signal.  a) The spectral CCD count rate from two 
nanospheres with inset AFM images (scale bar = 50 nm).  b) The calculated differential cross sections of 
the same nanospheres integrated over the solid angle of the objective.  c) The resulting spectral scattering 
constant.  
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2.5 Application to other particles 
 

2.5.1 Gold bipyramid 

 

Gold bipyramids have the shape of two elongated pentagonal pyramids connected 

at their bases. Bipyramids are synthesized by surfactant-directed growth (as are gold 

nanorods), but are much more monodisperse and generally larger in size.26  An individual 

135 x 53 nm bipyramid was located relative to alignment marks and characterized by 

environmental scanning electron microscopy (FEI Quanta 400 ESEM). The bipyramid 

was then immersed in oil, located in the dark field microspectrometer and its spectral 

count rate recorded.  The spectral scattering constant was applied to convert the data to 

the σobj presented in Figure 14.  As mentioned above, σobj represents the azimuthal 

average of the bipyramid differential cross section integrated over the objective lens’s 

solid angle.  The peak scattering cross section to the objective is 1.2 x 10-16 m2, and the 

narrow spectral width is consistent with previous reports of single bipyramid spectra.26 

In addition to the cross section, Figure 14 displays σobj for a sphere of the 

equivalent volume calculated from the full Mie solution as in Figure 13.  Under the 

imaging conditions reported here, the bipyramid is approximately two times brighter than 

its equivalent sphere. 
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Figure 14 The measured gold bipyramid scattering cross section (red) and the calculated cross section for a 
gold sphere of equivalent volume (green).  The inset shows an ESEM image of the bipyramid on glass 
(scale bar is 100 nm).  

 

2.5.2 Gold nanorod 

 

In an attempt to measure single nanorod scattering, it has been found that 

individual nanorods (up to 50 x 15nm) do not scatter sufficiently to be detected by dark 

field microscopy at NA=0.5 with a halogen lamp illumination.73 Figure 15a shows an 

AFM image a region near alignment marks that are also visible in the optical images (c 

and d).  A zoomed AFM image (b) reveals a large nanosphere in the upper right 

(triangular shape is a tip artifact) and a nanorod in the lower left. The nanorod is clearly 

revealed in the inset. Its size is exaggerated by the tip. Two detectors, a high sensitivity 

CCD (c) and a color CCD (d) were used, yet the individual particle does not scatter a 
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detectable amount of light. These small, dim particles, however, can be imaged by more 

sensitive methods such as confocal reflectance microscopy.70, 74, 75 

 

Figure 15 Individual gold nanorod ~50 x 15nm. AFM (a&b), and optical dark field (c&d). 
 

 

  In order to measure the differential scattering cross section of a single nanorod 

by dark field microscpectroscopy, an isolated patch of nanorods was created by 

scratching a nanorod film.  The one micron square patch contained 28 isolated nanorods 

with an average size of 40 x 13nm, as determined by AFM.  The dark field scattering rate 

was analyzed as above and divided by the number of nanorods in the patch to obtain the 

average cross section of a single nanorod (Figure 16).  The nanorod, being much smaller, 

is 100 times less bright than the bipyramid in the dark field microscope.  The peak is 

broadened due to the presence of various shapes of nanorods in the patch, which were 
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found to have lengths ranging from 33 to 57 nm and diameters ranging from 10 to 15 nm. 

The noise in the measurement is a result of being at the lower detection limit.  
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Figure 16 The average scattering cross section for a single nanorod (orange) measured from a patch of 28 
nanorods shown in dark field microscopy (top inset) and AFM (bottom inset, scale bar = 500 nm).  The 
calculated equivalent gold sphere cross section is also plotted (blue). 

 

For an ellipse of this size, the single particle approximations that are included in 

the Gans expression is correct to within 10%. Figure 17 shows the Gans solution total 

scattering cross section averaged over all illumination angles and nanorod sizes from the 

patch in Figure 16.  After fitting the average Gans solution to a Gaussian distribution, the 

ratio between the scattering peak of the elongated particle and the spherical particle is 

found to be approximately equal to the value measured for σobj (~7.5). Therefore, for 

particles of this size, the total scattering cross section is an accurate predictor of the 

relative contrast in dark field microscopy.  For larger particles of complex shapes, 

b
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however, it is likely that this relationship does not hold. Small particles tend to scatter in 

a dipole pattern, regardless of their shape. As particle size increases the angular scattering 

becomes less of a dipole pattern and exhibits more forward scattering. Particle shape will 

change this far-field scattering pattern in a way that cannot be described with simple 

analytical expressions. 

 

 

Figure 17 The average total scattering cross section calculated with the Gans Solution for the various sizes 
of nanorods in the spectrum measured in Figure 16 (fine line) with a Gaussian fit to that curve (dashed line) 
along with the total scattering cross section for a sphere of the equivalent average volume (bold line). 
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2.6 Discussion 
 

These measurements show that elongated plasmon resonant nanoparticles scatter 

more brightly than their equivalent volume spheres.  This is due to the reduced plasmon 

damping in gold at the near-infrared wavelengths of their peak plasmon resonance.19   

However, many other factors may affect the observed scattering signal, such as the 

increased wavelength, polarization dependence, and angular pattern of the scattered light.  

The Gans solution is only applicable to very small particles, therefore, in addition to the 

shape mismatch, it is of no use in predicting bipyramid scattering. 

These results are in good agreement with the report by Schultz et al. 63  The 109 

nm sphere in Figure 13a, integrated over detectable wavelengths, generates 

approximately 106 counts per second from the CCD, which correlates well to the photon 

flux reported by Schultz et al given that the measurements reported here are on a larger 

nanoparticle made of gold (as opposed to silver which supports stronger plasmon 

resonances), and using a lower NA objective.  Even bright fluorophores with extinction 

coefficients as high as 100,000 M-1cm-1 and high quantum efficiencies have emission 

cross sections on the order of 10-22 m2.  These results establish a baseline cross section 

detectivity of approximately 10-18 m2 for single nanoparticle scattering in the dark field 

setup described here, but that is certainly not a lower limit.  Transmitted illumination dark 

field microscopy with both oil immersion condenser and objective generally provides 

more signal (due to the higher NA) and a darker background.  Also, this geometry will 

capture scattering in the forward hemisphere, which is predominant for larger 

nanoparticles. However, this imaging mode may prove more difficult to calibrate since 

the illumination is manually aligned.  
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2.7 Conclusion 
 

The spectral scattering for a NA=0.5 dark field microspectrometer was calibrated 

using measurements on gold nanospheres and the corresponding full Mie theory solution.  

The calibration was applied to gold nanorods and bipyramids to quantitatively 

characterize their spectral scattering properties. These results show that elongated 

particles scatter strongly for their volume and are ideal for many applications that require 

small, bright nanoparticles. The brightness of small, elongated nanoparticles can be 

accurately predicted by simple small-particle formulas for the total scattering cross 

section. Larger particles, however, would be best treated with numerical calculations.  
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3 Gold Nanobelts 
 

This section will discuss the optical properties of gold nanowires with rectangular 

cross sections, referred to as gold nanobelts.76 This structure combines the tunability and 

sharp resonances of sub-wavelength sized nanoparticles with the extended structure of 

nanowires.  

3.1 Methods 

3.1.1 Gold Nanobelt Synthesis  

 

In a typical synthesis, aqueous CTAB (cetyltrimethylammonium chloride, 50 

mM, 650 µL) and SDS (sodium dodecylsulfate, 10 mM, 500 µL) were added to 3.45mL 

of DI water at room temperature. After allowing the surfactants to mix for several 

minutes, HAuCl4 (10mM, 100 µL) was added. The solution was then thermostated for 30 

minutes at 27°C. Finally, freshly prepared L-ascorbic acid (100 mM, 300 µL) was added 

and the solution was allowed to sit at 27°C for 12 hours. During the growth reaction, the 

solution gradually became turbid and exhibited a reddish hue (Figure 18a). The color is 

typical of plasmon resonant gold nanoparticle solutions, and the turbidity was due in part 

to the formation of micron-scale surfactant crystals that are visible in an optical 

microscope. The spectral extinction exhibits a weak band at 520 nm (Figure 18b), which 

is also consistent with the presence of gold nanoparticles. Small aliquots of as-prepared 

nanobelt solutions were deposited onto glass substrates and, allowed to dry, and then 

rinsed with methanol to remove the excess surfactant. For correlated measurements 

between the optical microscope and AFM/SEM/TEM, gold was evaporated over a TEM 
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grid and the pattern was used as a map to find the same particle in different instruments, 

as described on p.21. 

3.1.2 Gold Nanobelt Geometric Characterization 

 

 Figure 18 displays electron micrographs that illustrate the flat, elongated 

geometry of the structures.  The gold nanobelts described here have sub-100 nm cross-

sectional dimensions and lengths greater than 10 µm.  The high-resolution image and 

diffraction pattern are consistent with the previous report, which concluded that the 

nanobelt structure is single-crystalline gold that grows along the <211> direction and has 

a [111] plane on the top flat surface.  
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Figure 18 Gold nanobelts. The suspensions have (a) a pinkish turbid appearance, and (b) a weak plasmon 
resonant spectral absorption peak at 520 nm. Electron micrographs illustrate (c) the overall ribbon-like 
morphology and (d) high resolution crystalline structure.  (e) Electron diffraction confirms the single-
crystalline gold structure. 

 

Well-isolated belts that were near reference marks were chosen for spectral 

analysis.  The same nanobelts were imaged by tapping mode AFM under ambient 

conditions with a Nanoscope IV Multimode AFM (Veeco).  An image of the 100 x 20 nm 
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nanobelt from Figure 21 is in Figure 19. Note that the large structure at the top of the 

image corresponds to the yellow scattering at the end of the red nanobelt in Figure 21. 

The nanobelt heights and widths were taken from section analysis of the images. Figure 

20 shows the analysis of the 100 x 20 nm nanobelt from Figure 21 and Figure 19.  The 

height measurement is straightforward.  For the width, a flat top surface is assumed, and 

the curved edges are considered tip broadening and ignored.  

 

 
Figure 19 A tapping mode AFM image of the 100 x 20 nm gold nanobelt from Figure 21, 
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Figure 20 Section analysis of the AFM image in Figure 19.  The red markers yield a width of 100 nm, and 
the green markers yield a heigh of 20 nm. 

 

Here the cross-sectional aspect ratio, x-AR, is defined as the nanobelt width 

divided by the height.  Since these nanobelts are very long, the length to width aspect 

ratio that has been addressed in previous studies is not considered.71, 77  
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3.2 Dark Field Scattering Spectra: Transverse Plasmon Modes 
 

  Dark field measurements, as described in Section 1.2, were performed on gold 

nanobelts. As seen in the dark field images (50X/0.5 NA objective, Zeiss Axiovert 

200M), the existence of a tunable plasmon resonance is apparent, as nanobelts with low 

cross-sectional aspect ratio appear green and those with higher aspect ratio appear red. 

The nanobelt scattering spectra were recorded from the center of each belt by an imaging 

spectrograph and CCD camera.  White light was incident through the annular dark field 

objective and was unpolarized.  A polarizer behind the objective analyzed the scattered 

light and scattering images were recorded for polarizations parallel and perpendicular to 

the nanobelt length. As seen in Figure 21, the measurements reveal a plasmon mode 

polarized perpendicular to the nanobelt length which redshifts with increasing cross- 

sectional aspect ratio. Also shown are scattering spectra polarized parallel to the 

nanobelts, which were relatively featureless. The perpendicular spectra were plotted 

versus energy and fitted to find their line widths (Γ), which are also given in Table 1. 

x-AR Width (nm) Height (nm) Γ  (meV) 

1.0 25 25 268 

1.4 50 35 303 

2.1 55 26 308 

3.3 100 30 510 

5.0 100 20 358 

5.9 100 17 261 

Table 1 The nanobelt sizes and spectral line width from the data in Figure 21. 
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Figure 21 Dark field micrographs (left) and corresponding single nanobelt spectra (right).  The blue spectra 
are polarized transverse to the nanobelt, and the red spectra are polarized parallel to the nanobelt. 

 

Note that the measured spectra of the high cross-sectional aspect ratio nanobelts in 

Figure 21 appear to have some structure as though they are made up of multiple peaks.  

While such peaks can be attributed to substrate interactions,24 here they are artifacts of the 

data analysis.  Different choices of the background subtraction parameters cause 

somewhat different spectral shapes, although they do not affect the overall tunability.  In 

addition, the measured linewidths given in Table 1 are similar to the homogeneous 

linewidths of single gold nanoparticles.19 
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3.2.1 Numerical Simulations 

 

To understand the nature of the observed nanobelt plasmon resonance, finite-difference 

time-domain (FDTD) calculations were carried out for the nanobelt geometry using a 

measured dielectric function for gold.78 The simulation geometry, shown schematically in 

Figure 22a, was designed to match the experimental dark field spectroscopy 

measurements. Illumination was incident at 45 degrees to the nanobelt long axis (as in the 

experiment) and the total scattering cross section for an infinitely long nanobelt was 

calculated.  The infinite nanobelt was simulated by extending it through perfectly 

matched layer boundary conditions that minimize reflections.79  With the incident k-

vector along the nanobelt length and TE polarization across the nanobelt as shown in 

Figure 22a, a scattering resonance was found (Figure 22b) that shifts with aspect ratio in 

a manner similar to the experimental measurement. Analysis of the charge and field 

distributions showed that the bright scattering resonance is a plasmon mode with 

antisymmetric charge alignment across the nanobelt width as depicted by the charge 

distribution plot in Figure 22c. Note that the simulation results in Figure 22 do not 

include the substrate. A scattering spectrum was simulated by the finite element method 

(FEM) method for a gold nanobelt with cross-sectional aspect ratio of 3.3 both with and 

without a glass substrate.  As seen in  

Figure 23, the substrate caused an 18 nm red shift, but otherwise had no significant 

impact on the spectrum. 
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Figure 22 (a) Gold nanobelt simulation geometry and (b) resulting spectra for cross-sectional aspect ratios 
that match Figure 21 (c) The calculated charge distribution of the scattering mode.  

 

Figure 23 The total scattering cross section calculated by FEM for a gold nanobelt with (green) and 
without (red) a glass substrate. 
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To more closely match the experimental measurement, FDTD simulations were also 

carried out for a finite nanobelt and the differential scattering cross section was 

calculated. Due to computational complexity, these simulations were performed on a 

nanobelt of only 0.4 micron length, which resulted in strong Fabry-Perot resonances that 

do not occur in this experiment because the nanobelt lengths are greater than 10 microns. 

The experimental data is therefore compared to the total cross sections calculated for 

infinite nanobelts.  

Other plasmon modes were found in the simulations that were not evident in the 

experiments. For instance, for TM polarization, the calculations revealed an 

antisymmetric mode, with its dipole moment oriented in a zig-zag pattern along the 

nanobelt length (Figure 24).  This peculiar orientation of the dipole moment is due to an 

admixture of symmetric and antisymmetric plasmon modes on the upper and lower 

surfaces of the nanobelt.80  The zig-zag mode was found to predominantly scatter in a 

direction outside the numerical aperture of the microscope objective, so it was not 

observed.  
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Figure 24 The calculated charge distribution of the zig-zag mode at 624 nm excited by incident TM 
illumination. 

 

3.2.2 Discussion 

 

Spectral scattering peaks for both the experiments and simulations were fitted to 

analyze the tunability of the transverse plasmon resonance in the nanobelt structure.  The 

results, plotted in Figure 25, agree well and reveal an approximately linear relationship 

between the cross-sectional aspect ratio and resonance wavelength, which is very similar 

to the behavior for elongated nanoparticles such as gold nanorods.64  Interestingly, the 

nanobelt structure has a lower sensitivity to the cross-sectional aspect ratio, shifting only 

100 nm (~525 nm to ~625 nm) with cross-sectional aspect ratio increasing from 1 to 5.  

In contrast, gold nanorods (with their aspect ratio defined as the ratio of the length and 

width) shift over a similar spectral range with an aspect ratio change of only 1 to 2.5.81 

An additional increase in the nanobelt cross-sectional aspect ratio through synthesis may 

enable the plasmon resonance to be further tuned to the near infrared. 
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Figure 25 The dependence of the plasmon resonance peak on cross-sectional aspect ratio in the 
experiments (solid circles) and simulations (hollow circles). 

 

3.2.1 Mie Scattering for an Infinite Cylinder 

Although strong transverse resonances have not been previously reported in 

plasmonic nanostructures, the problem of light scattering from an infinite cylinder can be 

solved analytically. By solving Maxwell’s Equations in a cylindrically symmetric system, 

as outlined by Bohren and Huffman58 (p.194) and summarized here, it is possible to 

obtain the scattering cross section for an arbitrary size of cylindrical nanowire. For small 

sizes, a strong transverse plasmon mode is predicted for cylinders. This resonance, 

however, is not strongly tunable and quickly broadens with increasing cylinder radius.  

In this case, the Mie scattering coefficients an and bn for an infinite cylinder consist of 

parallel and perpendicular components. In an infinite cylinder with normally incident 

light, the plasmonic response is separated into components along both parallel and 

perpendicular axes.  
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As in the problem of absorption scattering by a sphere, the starting point is the 

vector wave equation ∇!! + !!! = 0. Written in cylindrical polar coordinates, this 

equation becomes 

1
!
!
!" ! !"!" + 1

!!
!!!
!!! + !

!!
!!! + !

!! = 0 

Solutions to this equation that are single-valued functions of ! are of the form 

                                     !! !,!, ! = !!(!)!!"#!!!!                 (! = 0,±1,… ) 

where ! = ! !! − ℎ! and !! is a solution to the Bessel equation 

! !
!" ! !

!" !! + !! − !! !! = 0 

The linearly independent solutions to this equation are Bessel functions of the first and 

second kind. In general, the separation constant h is unrestricted. The vector cylindrical 

harmonics generated are 

!! = ∇× !!!! ,!!!!!!!!!!!!!!!!!!!!!!!!!!! =
∇×M!
!  

where the pilot vector is the unit vector!!!!, parallel to the cylinder axis.  

In component form 

!! = !! − ℎ! !" !!(!)! !! − !!! (!)!! !!(!"!!!) 

!! =
!! − ℎ!
! !ℎ!!! ! !! − ℎ!

!! !
! !! + !! − ℎ!!!(!)!! !!(!"!!!) 
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where M and N are orthogonal. Similarly to Section 2.1.1 where the incident wave was 

expanded in vector spherical harmonics to solve for scattering from a sphere, both the 

incident electric field parallel (along the cylinder axis) and perpendicular (transverse to 

cylinder axis) to the xz plane and the incident electric field must be expanded in vector 

cylindrical harmonics. Starting with the field parallel to the cylinder axis: 

!! = !!!!! ! !!!;!!
!

!!!!
!! =

−!"
!" !!!!

!(!)
!

!!!!
 

 

At large distances from the cylinder axis, the first and second order generating functions 
tend to zero, and the scattered far-fields are given as:  

!! = − !! !!!!!! + !!!!!!
!

!

!!!!
!; !!! =

!"
!" !!!!!

! + !!!!!!!
!

!!!!
 

When the incident light is normal to the cylinder axis, it follows from the relations 
!!! = (−1)!!! that 

!!!! = −!!!, !!!! = !!!, !!! = 0. 
In this configuration ! = 90∘ ,!!! vanishes and  

!!! ! = 90∘ = !! =
!! !" !!! ! −!!!! !" !!(!)

!! !" !!!
! ! −!!!! (!")!!! (!)

 

 

Similarly, for incident light perpendicular to the xz plane: 

!! = −! !!!!
!(!)!

!

!!!!
 

the curl of which gives the incident magnetic field.  

!! = !! !!!!!!! + !!!!!!!
!

!

!!!!
! 

It follows that  !!!! vanishes and 
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!!!! ! = 90∘ = !! =
!!!! ! !! !" − !! ! !!! !"

!!! !" !!! ! ! − !!! !" !!(!) !
 

The incident and scattered fields of each polarization can be related through a scattering 

matrix (Bohren & Huffman p.202). From there, the Poynting vector and the total energy 

scattered can be obtained, leading to the scattered light per unit length of the cylinder:  

!!"#,! =
2
! !!! ! + 2 !!! ! + !!! !

!

!!!
         (10) 

 

!!"#,!! =
2
! !!!! ! + 2 !!!! ! + !!!! !

!

!!!
                            (11) 

 

 

 Forms of these equations that are optimized for computation are outlined in 

Appendix C of Bohren and Huffman58. Matlab program was written to solve for the 

scattering and extinction of an infinite cylinder (Appendix E: Mie Scattering from an 

Infinite Cylinder). Figure 26 shows the plasmonic response of a 10nm diameter infinite 

cylinder both transverse to, and along the axis of the cylinder. Due to the small radial 

size, the transverse resonance is narrow, as in the case of the nanobelts. The peak due to 

the longitudinal oscillations of electrons, however, is not a resonance (a standing wave or 

mode), but is the result of interband transitions in gold. Note that the magnitude of the 

longitudinal plasmon response is much smaller than that of the transverse response. 

Figure 27 shows the scattering cross section transverse to the cylinder axis for a 

range of cylinder radii. The plasmonic response perpendicular to the cylinder length 

exhibits a strong, narrow resonance for small sizes, but with increasing size, does not 

exhibit a substantial peak shift and quickly broadens in linewidth.  
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Figure 27 Scattering for infinite cylinders with a range of radii (logarithmic scale). 

 

As seen in Figure 28, the transverse plasmon resonance peak of a small cylinder is 

similar in linewidth to the rectangular cross sectioned gold nanobelt (<115nm, as 

calculated and shown in Figure 22), but as cylinder radius grows, the peak quickly 

broadens. This is why most chemically synthesized nanowires appear white in dark field 

microscopy.  

Figure 26 Light scattering from an infinitely long, 10nm diameter cylinder transverse (left) and along 
the cylinder axis (right). Notice the difference in magnitude. 
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Figure 28 Calculated peak widths of infinite gold cylinders. 

 

3.2.2 Conclusion 

 

The results presented in this section describe a simple synthetic route towards an 

extended structure that exhibits sharp plasmon resonances for antisymmetric excitation 

across the nanobelt width. This transverse resonance is shown to be very narrow and 

tunable when compared to conventional cylindrical nanowires. These structures may find 

applications as sub-wavelength plasmonic bandpass filters, only allowing light of specific 

wavelengths determined by the cross-sectional geometry to be transmitted. Furthermore, 

gold nanobelts may be considered for biological applications that currently employ 

tunable nanoparticles.  The larger size of the nanobelts will provide a larger scattering 

cross section for imaging contrast or detection, and nanobelts may offer unique 

interactions with cells and tissues due to their size and shape. 
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3.3 Tapered Gold Nanobelts 

3.3.1 Characterization 

 

The nanobelt synthesis outlined in section 3.1.1 has various products beyond the 

uniform nanobelts discussed in the last section. Based on an analysis of many nanobelt 

images like Figure 29, approximately 10% of the gold nanobelts are uniform and the rest 

show significant variations in color along their length. While most vary with no 

discernible pattern, about 10% of the nanobelts exhibit a uniform transition from green to 

red due to a smooth change in aspect ratio.  

 

Figure 29 Optical dark field image of gold nanobelts produced in a typical synthesis. A range of nanobelt 
lengths, plasmon resonant frequencies, and structures are produced by the synthesis. 

 

Several examples of uniformly tapered nanobelts are displayed in Figure 30, 

where the width variation occurs over lengths scales of nanometers to microns. The 

transmission and scanning electron micrographs (Figure 30a and Figure 30b respectively) 

directly display the variation in width, while the dark field optical image (Figure 30c) 

shows it indirectly through the variation in color. A single tapered nanobelt was analyzed 
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in detail by correlated atomic force microscopy and microspectroscopy. The peak 

wavelength and cross-sectional aspect ratio (width/ height) are plotted in Figure 31 along 

with the previously reported points for uniform nanobelts.82 The tapered nanobelt peak 

wavelengths match those from uniform nanobelts, and confirm that the shift in color is 

due to a change in cross-sectional aspect ratio. 

 

Figure 30 (a) TEM, (b) SEM, and (c) optical dark field images of tapered gold nanobelts that occur at 
different scales. 
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Figure 31 A tapered gold nanobelt characterized by (a) dark field microscpectroscopy showing spectra 
taken as a function of position along the belt (dark field image inset), (b) AFM. (c) The spectral peak 
wavelength along the tapered nanobelt (filled circles) plotted against x-AR with the spectral peak for 
uniform belts from a Section 3.2 (hollow circles). 

 

 

3.3.2 The “Plasmometer” 

The spatial dispersion of the plasmon resonant wavelength enables the tapered 

nanobelts to act as mesoscopic spectrometers for plasmonic interactions. Here, light 

emission from quantum dots near tapered gold nanobelts is described as an example. 

Plasmonic nanostructures enhance the electromagnetic field near their surface, which can 
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increase the absorption cross section and therefore enhance the excitation rate of a 

chromophore. The radiative decay rate may also be enhanced, and together these effects 

can increase the brightness of a nearby chromophore.83, 84 The plasmonic nanostructure 

can also open new non-radiative decay channels, resulting in quenched chromophore 

emission.85 These interwoven effects each have complicated dependences on the 

chromophore’s position and orientation relative to the nanoparticle, the nanoparticle’s 

electromagnetic near field enhancement pattern, and the spectral properties of both the 

plasmonic nanostructure and the chromophore. However, it is important to deconvolute 

their effects especially since excitation and emission contribute to different applications.86 

This has been achieved by studying different nanoparticles at different plasmon 

energies,62, 86-90 but tapered gold nanobelts may bring unique capabilities due to the spatial 

separation of a continuum of plasmon resonances. 

3.3.3 Methods 

To demonstrate their spectroscopic capabilities, gold nanobelts on a glass 

substrate were then covered with a 20 nm thick layer of evaporated SiO, then spin-coated 

with a ~50nm polystyrene containing CdSe/ZnS quantum dots. CdSe/ZnS core/shell 

quantum dots capped in octadecylamine were purchased from Ocean NanoTech. The 

quantum dot emission peak was centered at λem = 600 nm with a quantum yield of over 

50% (emission profile shown in Figure 32). The quantum dots were first dispersed in 

toluene at a concentration of 10mg/ mL. A 2% polystyrene solution in toluene was then 

prepared.  Finally, a mixture of 588 uL of the 2% polystyrene solution and 12 uL of the 

quantum dot solution was prepared.   
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Figure 32 Emission profile of quantum dots used for emission enhancement studies, reproduced from 
specifications provided by Ocean NanoTech.  

 

The spin coating process causes the quantum dots to segregate into domains on 

top of the film. This, along with the SiO layer results in the quantum dots being well-

separated from the nanobelts (see AFM images in Figure 33).91   
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Figure 33 AFM of a glass substrate with a gold nanobelt that is covered by a polystyrene film with CdSe 
quantum dots.  The (a) section analysis reveals the film thickness and (b) reveals islands of CdSe quantum 
dots situated on top of the polystyrene. 
 

 

Dark field images were obtained with the same microscope and objective as the 

dark field system described section 2.3. Fluorescence images required using a 

fluorescence filter set rather than dark field illumination annulus and a Nikon D5000 

color camera.  The quantum dot emission and filter set curves are shown in Figure 34. 

Fluorescence images in counts were converted to emission enhancement by dividing the 

image counts by the average background counts from a region with no nanobelt. In this 

way, the emission enhancement of the background is 1 (no enhancement) and the image 

directly displays the enhancement above the nanobelts. 
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Figure 34 The spectral transmittance of the fluorescence filter set and the measured spectral quantum dot 
emission. 

 

3.3.4 Results 

Figure 35 presents both dark field scattering and fluorescence microscopy images 

of three tapered nanobelts on the substrate. For each nanobelt, the dark field image 

reveals which end is resonant near the emission peak of the quantum dots (λem = 600 nm). 

The enhancements are clearly more prominent at the red end of the nanobelt where the 

plasmon resonances match the quantum dot emission, which indicates an enhanced rate 

of emission rather than excitation.  The enhancement values near the nanobelts are 

similar in magnitude to those reported for quantum dots near single silver nanoprisms.86 

Also, if quenching were to occur off the emission resonance, it would appear as a dip in 
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the fluorescence background, which is not observed for sufficient nanobelt/quantum dot 

spacer layers.   

 
Figure 35 Quantum dot emission enhancement near a tapered gold nanobelt. The dark field images 
illustrate the wavelength and spatial location of the plasmon resonances, while the fluorescence images 
show increased quantum dot emission at the red end of the taper. 

 

3.3.5 Conclusion 

Tapered nanobelts have uniformly varying cross-sectional aspect ratio and peak 

plasmon frequency along their length. This spatial dispersion creates mesoscopic 

“plasmometers” to study enhanced light emission or other plasmonic effects. This 

capability was demonstrated by the spatially varying emission enhancement of quantum 

dots near tapered nanobelts. 
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3.4 Split Gold Nanobelts 

3.4.1 Introduction 

 

Another novel product of the nanobelt synthesis (Section 3.1.1) that is regularly found 

in these samples is the nanobelt dimer. In this structure, two nanobelts run side by side 

with a small, uniform sub-10 nm gap for lengths greater than one micron. Images of 

nanobelt dimers, displayed in Figure 36, suggest that these can form when two nanobelts 

come together upon deposition (Figure 36a, b).  In other cases, it appears that the 

nanobelt splits during synthesis (Figure 36c) leading to two parallel daughter nanobelts. 

Nanobelt dimers may serve as an interesting nanostructure geometry for plasmon 

hybridization,92 and they may create unique modes for plasmon propagation along the 

nanobelts considering they concentrate the electromagnetic field in the space between the 

nanobelts similar to plasmonic slot waveguides.93-95 Plasmonic substrates have been 

shown to increase the molecular Raman Scattering signal from the bond vibrations within 

molecules near the metal surface because of large electric field enhancements.  Because 

of the large gap with a well-defined spacing, nanobelt dimers may also serve as substrates 

for analytical SERS applications, which rely on large volumes of well-defined 

electromagnetic field enhancement.96-98  
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Figure 36 (a) TEM image of a gold nanobelt dimer showing that the two branches of the nanobelt run 
together with a uniform gap and (b) SEM of a nanobelt as it splits. (c) AFM imaging can also identify 
nanobelt dimers. 

 

3.4.2 Methods 

To evaluate their potential for analytical SERS, nanobelts were deposited on a 

glass slide from their native mixed surfactant solution and dried. A nanobelt dimer was 

located by AFM relative to alignment marks. SERS measurements were taken on the 

nanobelt dimer, on a single nanobelt, and on the bare glass substrate, all of which were 

covered with surfactant. Figure 37 displays the AFM image of the nanobelt dimer and 

includes an optical view of the excitation laser spot location. The laser was polarized 

horizontally across the vertically aligned nanobelt dimer.  
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To analyze the magnitude and spatial distribution of the field enhancement in the 

nanobelt dimer, the structure was simulated using the commercially available Finite 

Element Method (FEM) package, COMSOL Multiphysics (for step-by-step details of the 

simulation set-up, see Appendix D: COMSOL Multiphysics Simultation). The dielectric 

function of gold was taken from Johnson and Christy78 and was interpolated using a 

linear interpolation method. Since the AFM image do not provide a precise gap size, a 

typical structure was simulated based on TEM observations: two 20 nm by 50 nm 

nanobelts separated by a 3 nm gap (Figure 38).96 A schematic of the simulated nanobelt 

dimer is shown in Figure 39. 

Figure 37 AFM of a nanobelt dimer with (inset) the optical image of the dimer in the 
Raman microscope. 
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Figure 38 A high-resolution image of the gap of a nanobelt dimer. 

 

 

Figure 39 Schematic of the nanobelt dimer. 

 

The nanobelt dimers were simulated as 2D cross sections with infinite length. The 

simulated belt edges had a radius of curvature of 2nm. Perfectly sharp corners may pose 

problems with FEM techniques; also, perfectly sharp nanobelt corners are not physically 

realistic. A 1.1 μm circular simulation space surrounded the dimer cross section with a 

200 nm thick perfectly matched layer (PML) to absorb waves reflected from the 

simulation space boundaries. The electromagnetic enhancement (! = !/!!) was 

calculated at both the incident laser wavelength of 785 nm and a Raman shifted 

wavelength of 858 nm (which corresponds to a ~1200 cm-1 shift typical of a hydrocarbon 

mode), which was polarized perpendicular to the gap.  
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3.4.3 Results 

SERS measurements were preformed on the nanobelt dimer shown in Figure 37. 

These measurements were compared with the signal from the glass substrate and single 

nanobelt. Both the glass and single nanobelt showed no significant SERS signal. The 

nanobelt dimer yielded several strong peaks between 900 and 1500 cm-1 which 

correspond to alkane chain modes of the surfactants (Figure 40).96   

 

Figure 40 The corresponding SERS of dried surfactant on the nanobelt dimer (blue), on a single nanobelt 
(green), and on the glass substrate (red). 

 

The result of the COMSOL simulation are shown in Figure 41, show a region 

between the nanobelts with field enhancements (!,!′, where the prime denotes the field 

at the scattered frequency) reaching 16 and 12 for the incident and scattered wavelengths 

respectively, and yielding an overall enhancement factor (!" = !!′ !) of ~37,000. The 

total enhancement is not especially high, but that is expected given the large separation 

(relative to typical hot spots) and the lack of curvature in one dimension. The 

enhancement is similar to those at the ends of gold nanorods that were observed in a 
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recent analytical SERS study with this instrument (15,000 – 84,000).96  Simulations of a 

single nanobelt generate a field enhancement at the corners of approximately 6 and an 

enhancement factor of only 1300 (shown in Figure 42). 

 

Figure 41 The theoretical electromagnetic enhancement of its cross section with a 3 nm gap at (top) 785 
nm and (bottom) 858 nm. 

 
         Figure 42 Electric field enhancement of a single belt at (top) 785 nm and (bottom) 858 nm. 

 

Calculating the SERS enhancement factor, (!" = !!′ !) in between the belts for 

the 1200cm-1 Raman shift (hydrocarbon mode) for a range of excitation wavelengths, the 

near-field enhancement spectrum for a belt dimer is shown in Figure 43. With small 

nanobelt seperations, these spectra are highly sensitive to the gap size, however, in 

theory, could be used to optimize future experiments. 
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Figure 43 SERS enhancement spectrum the 1200cm-1 shift hydrocarbon mode for various excitation 
wavelengths for two parallel 20 x 50nm gold nanobelts with a 3nm separation.  

 The same procedure for the single belt gives us the SERS Enhancement factor 

near one corner of the belt (highest region of enhancement) (Figure 44). The 

enhancement spectrum is weaker, blueshifted, and more narrow than the belt dimer case, 

as would be expected. 
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Figure 44 SERS enhancement spectrum the 1200cm-1 shift hydrocarbon mode for various excitation 
wavelengths for a single 20 x 50nm gold nanobelt. 

 

3.4.4 Conclusion 

 

Nanobelt dimers with uniform sub-10 nm gaps over micron-scale lengths were 

described. These structures have sufficient electromagnetic field enhancement to yield 

SERS spectra from molecules in the gap, and uniquely create large enhancement volumes 

since the gap runs through the entire excitation beam spot.  These nanostructures are 

created by a simple chemical synthesis and can be easily identified by optical or AFM 

imaging, making them widely available for further study and development.  
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3.5 Gold Nanobelts as Plasmonic Waveguides 

3.5.1 Introduction 

Gold and silver nanostructures have been actively investigated for manipulation of light 

at the nanometer scale since they localize light to deep sub-wavelength dimensions 

through the formation of surface plasmons. 13 Nobel metal nanowires support surface 

plasmons that propagate along their length. These propagating plasmons may serve as 

interconnects in future nanophotonic circuitry, where light is coupled into one end of a 

nanowire and emitted at the other.42, 46, 56, 99 Looking beyond the classical description, 

propagating plasmons in nanowires are quasiparticles that retain the quantum information 

of the photons that generate them.100-103 Intriguing device architectures have been 

considered based on strong interactions between quantum emitters and plasmonic 

nanowires, including all optical transistors and single photon sources.51, 53 However, the 

intrinsic losses in gold and silver at optical frequencies limit the propagation distances to 

several microns. Recent attention has focused on characterizing the propagating modes, 

and how the propagation lengths depend on nanowire geometry, wavelength, dielectric 

environment, substrate, and metal crystallinity. 43, 56, 57, 104-110 

Silver exhibits lower intrinsic losses than gold, and has been the focus on most work on 

plasmon propagation in nanowires.43, 56, 101, 108-112 The propagation can be directly measured 

with far field optics by focusing a light at one end of the nanowire and observing 

emission at the other end. Chemically synthesized silver nanowires yield the longest 

propagation lengths, while lithographically fabricated wires offer the opportunity to 

investigate complex nanowire architectures. Reflections of surface plasmons at nanowire 

ends result in Fabry-Perot resonances within the nanowire which can be probed to 
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extrapolate the wavelength and decay length of propagating plasmons.56, 105, 107-110, 112 

Experimental results are in good agreement with both analytical solutions and numerical 

simulations using the measured dielectric function of silver.  

There is much interest in increasingly thinner nanowires to explore strong interactions 

between propagating plasmons and nearby quantum emitters.55 However, smaller 

diameter nanowires have shorter propagation lengths and weaker emission signals. In 

addition, gold is superior to silver in terms of chemical stability and ease of 

functionalization, but again the higher intrinsic loss in gold leads to shorter propagation 

lengths. Plasmon propagation in gold nanowires is therefore difficult to study with far 

field optics since the emitting nanowire end will be dim and imaged very close to the 

brightly scattering excitation end. Recent reports have found alternative methods to study 

gold nanowire propagation. Through excitation by total internal reflection at the surface 

of a prism, emission from lithographically fabricated gold nanowires was observed and 

spectrally analyzed. A Fabry-Perot model yielded a decay length of 2 to 4 µm depending 

on frequency, although the Fabry-Perot fringes were not as clear as those for silver 

nanowires.105 Propagation in gold nanowires has been observed by near field excitation of 

fluorophores. Fluorescence images of Coumarin 30 near the nanowires yields 

propagation lengths of 2.4 to 3.6 µm.107 Also, a method has been developed based on the 

near field bleaching of flourophores and monitoring their recovery. This yields 

propagation lengths of 1.8 +/- 0.4 µm at a wavelength of 532 nm57 and 7.5 +/- 2.0 µm at 

785 nm.106 With this method, the fundamental propagating mode (m=0) is quenched by 

the fluorophore layer. The longer measured propagation length in these experiments was 

found to be due to a higher-order propagating mode (m=1) which decays much slower 
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than the fundamental propagating mode. All of these results are in reasonable agreement 

with theory, but each is either indirect or relies on models with some assumptions (such 

as reflectance coefficients of the nanowire ends) or some ambiguity regarding the 

propagating mode. 

 

3.5.2 Methods 

Gold nanobelts are attractive structures for plasmon propagation due to their single 

crystal gold structure, their relatively small cross-sectional size for strong confinement, 

and their flattened cross sections, which may lead to stronger interactions with nearby 

emitters. For plasmon propagation experiments, gold nanobelts on glass substrates were 

imaged with an oil immersion 100X/NA=1.25 objective under epi-brightfield 

illumination with a white light emitting diode (LED). To observe plasmon propagation, a 

separate 850 nm LED was positioned approximately 1 meter behind the objective lens 

and coupled in with a pellicle to produce a tightly focused spot in the object plane. The 

focused light was placed at one end of the nanobelt and light emission was observed at 

the other end, as seen for two short nanobelts in Figure 45. Efforts to generate 

propagation images like those in Figure 45 with focused laser spot were unsuccessful due 

to the background of interference fringes and speckle patterns inherent to high coherence 

illumination. With low coherence LED illumination, the background is smooth and easily 

subtracted.  
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Figure 45 Two gold nanobelts imaged with a,b) epi-bright field illumination and c,d) focused illumination 
to display propagation. The left nanobelt (a,c) is 1.6 µm in length and the right nanobelt (b,d) is 1.8 µm. 
The illumination wavelength is 850 nm. 

To compare these measurements with previous reports on silver nanowires, similar 

experiments were performed with 100 nm diameter silver nanowires synthesized 

following the extensive parametric polyol synthesis study by Coskun et al.113 Using a 

polyvinylpyrrolidone (PVP, MW = 55,000) to silver ratio of 3:1.1 A 10 mL solution of 

ethylene glycol containing 0.45 M PVP (monomer-based molarity) and 0.007g NaCl was 

heated in a round bottom flask to 170 °C under moderate stirring. Once the solution was 

at a constant temperature, 5 mL of 0.12 M AgNO3 dissolved in ethylene glycol was 

injected into the flask at a rate of 5 mL/hour. After all of the AgNO3 solution was added, 

the flask was held for an additional thirty minutes at 170 °C before being cooled to room 

temperature. At this point the solution was opaque and pale gray in color. 

The solution was then added to 75 mL of acetone and centrifuged at 6,000 rpm for 

20 minutes. The supernatant was decanted. The remaining gray precipitate was then 

resuspended in acetone and washed again following the same procedure. Finally, after the 

second round of decantation, ethanol was added and the resulting product was briefly 
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probe sonicated to suspend the nanowires.  The silver nanowires were imaged by optical 

dark field (Figure 46), atomic force microscopy (Figure 47), and transmission electron 

microscopy (Figure 48), and plasmon propagation (Figure 49) was studied as described in 

the text. 

 
Figure 46 An optical dark field image of the silver nanowires in solution. 

 

 

 

 
Figure 47 Atomic force microscopy images, recorded on glass with tapping mode, of silver nanowires. 
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Figure 48 A transmission electron micrograph of two silver nanowires.  The scale bar is 50 nm. 

 

    
Figure 49 A single silver nanowire (a) imaged in epi-bright field at 850 nm, and (b) imaged with an 850 
nm LED focused at one end.  The emission at the other end is seen in the lower right corner. 

 

 

 

3.5.3 Plasmon Propagation Lengths in Gold Nanobelts 

 

The propagation lengths were determined from measurements on gold nanobelts 

and silver nanowires with different lengths. However, the data must be corrected for 

different nanowire diameters and nanobelt heights and widths since the size affects the 

quantity of light absorbed and re-emitted. Rather than correct the data with detailed size 

measurements and scattering calculations, three relevant processes that scale with size 

were considered for a cylindrical nanowire of radius r, as illustrated in Figure 50a. At the 

illuminated end the absorption of light will scale as r3 (roughly treating the nanowire end 
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as a sphere). Emission at the distal end will also scale approximately as r3. Taken 

together, the entire process will scale as r6. Direct scattering at the illuminated end also 

scales as r6 (again approximating the end as a sphere) and can be measured from the 

experimental images. Both the excitation scattering and distal emission images were 

converted to signal rates (counts/second), and the emission and excitation scattering were 

scaled for each nanobelt or nanowire. The ratio is plotted versus nanowire length in 

Figure 50 for both silver nanowires and gold nanobelts. Uncertainties were taken as the 

square root of the total counts for both the tip image and the nearby background. The data 

were fit to simple exponential decay by nonlinear least squares regression, weighting 

each data point by its uncertainty. The resulting propagation lengths were 8.0 µm for 

silver nanowires (with a 3.6 to 35 µm 95% confidence interval) and 0.94 µm for the gold 

nanobelts (with a 0.61 to 2.1 µm 95% confidence interval). 
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Figure 50 The plasmon propagation length of gold nanobelts and silver nanowires. a) A schematic that 
illustrates the scaling rationale. b) Emission/excitation rates for gold nanobelts (circles) and silver 
nanowires (squares), with the exponential decay fits resulting in 0.94 and 8 µm propagation lengths, 
respectively. 

 

Even using the emission/excitation ratio to account for different sizes, there is still 

significant scatter in the data and significant uncertainty in the resulting propagation 

lengths. While plotting the emission/excitation ratio accounts for the different signal 

magnitudes, it does not account for the fact that different nanowire diameters have 

different decay lengths. Since each point in Figure 50 corresponds to a nanowire or 

nanobelt of different size, each point also corresponds to a different plasmon propagation 
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length, and the resulting fit is therefore an average. The expected propagation lengths for 

thin cylindrical gold nanowires were calculated by solving the electromagnetic wave 

equation for an infinitely long right circular cylinder. Boundary conditions lead to the 

following characteristic equation for the fundamental mode: 

 

 

Following Chang et al,55 R is the nanowire radius, k1 is the wave vector in the surrounding 

dielectric medium and k2 is the wave vector in the nanowire: 

   

where ε1 and ε2 are the dielectric functions of the medium and nanowire, respectively. ko 

is the magnitude of the vacuum wave vector and Jo and Ho are Bessel functions. The 

surrounding dielectric of immersion oil and glass was set to ε1=2.23 and ε2 was assumed 

to be the dielectric function of gold from Johnson and Christy.78 The solution to this 

equation reveals the complex wave number for a specific nanowire diameter and 

excitation wavelength. The imaginary part of the wave number, kI, yields the expected 

propagation length. The predicted decay lengths for gold cylinders are shown in Figure 

51. The measured average propagation length (line) and 95% confidence interval (dash) 

are shown. 
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Figure 51 The calculated plasmon decay length as a function of nanowire diameter for cylindrical gold 
nanowires in a surrounding dielectric.  

 

The average propagation length measured for gold nanobelts is what one would 

expect for 45nm diameter gold wire, and 30-80nm diameter wires fall within the 

confidence interval of the measurement. The gold nanobelt propagation lengths are 

therefore, within the range of what would be expected for a structure of this size.   

3.5.4 Propagating Modes 

Figure 52a and Figure 52b show a dark field and propagation image, respectively, 

for a particular gold nanobelt that was measured in AFM. The 5.5µm long, 125nm wide, 

40nm tall belt has the smallest cross-sectional area of any elongated structure that has 

been shown to support propagating plasmons. From earlier characterizations of nanowire 

modes,106, 107 two dominant propagating modes were expected. Figure 52c shows the 

calculated charge distribution for a nanobelt of this size (topview) of both the 

fundamental m=0 mode and the higher-order m=1 mode. The fundamental mode is 

generally the expected propagation mode for thinner nanowires.50 Figure 52d shows the 
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FDTD-calculated Poynting vector on a logarithmic scale. This plot of the directional 

energy flux is proportional to the emission that would take place if the belt were to 

terminate at that given length. Simulations predict that the m=0 mode is much stronger at 

shorter lengths, but decays more quickly than the m=1 mode, leaving the m=1 mode to 

dominate at longer lengths.  

             

Figure 52 a) Dark field image of 5.5µm long, 125nm wide, 40nm tall gold nanobelt. b) Plasmon 
propagation image of the same nanobelt, illuminated at one end with a 850nm LED. c) AFM of the 
nanobelt cross section. d) Calculated charge distribution for the fundamental m=0 mode and the higher-
order m=1 mode (scale bar = 100nm). e) Calculated Poynting vector for two propagating modes along a 
125nm x 40nm nanobelt.  

To illustrate how sensitive the mode cross-over length is to geometry, Figure 53 

shows the propagation length for the m=0 and m=1 modes for a 100nm wide, 25nm tall 
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nanobelt. Here, the cross-over to the m=1 mode dominating happens at a much shorter 

length (~5.2mm) than the 125nm x 40nm nanobelt (~7.6mm). 

         

Figure 53 Calculated Poynting vector for two propagating modes along a 100nm x 25nm nanobelt.  

 

FDTD calculations show that for this experimental geometry, the m=0 mode results in 

emission at the nanobelt tip that is highly polarized parallel to the belt length and the m=1 

mode emission is polarized transverse to the belt.  Angular scattering patterns for a 

125nm x 40nm nanobelt lying along the vertical axis are shown in Figure 54. These 

signals were integrated over the experimental detection angle to find that for the m=0 

mode, tip emission in the longitudinal polarization is ~7 times greater than in the 

transverse polarization. For the m=1 mode, the transverse polarization emission is ~30 

times that of the longitudinal polarization.  
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Figure 54 The angular scattering patterns of the tip emission for both modes, x and y polarizations. 

 

This result makes sense based on the direction of the electric fields in both cases and 

considering that light is always emitted perpendicular to an electric field. The 

fundamental mode results in electric fields perpendicular to the belt, the m=1 mode 

parallel to the belt (Figure 52). To identify the propagation modes present, a Wollaston 

prism was placed in the path of the emitted and scattered light. This element consists of 

two orthogonal calcite prisms, connected at their bases, which spatially separate the two 

polarizations of the signal. One axis of the prism was rotated to the orientation of the 

nanobelt on the sample so that the resulting images were of the light emitted parallel and 

perpendicular to the nanobelt. Nanobelts of similar brightness to that of the nanobelt 

measured in AFM were chosen. Measurements on nanobelts with geometric defects or 

bulbus end shapes were ignored as it was seen to affect the emission polarization. 



 78 

 

  

Figure 55a and Figure 55b display doubled propagation images with both polarizations 

of the scattering and emission signals for a 2.4µm and a 5.8µm long gold nanobelt, 

respectively. In order to get measurable emission for the longer nanobelt in part b, the 

excitation signal was saturated. The scattering at the excitation end of the shorter 

nanobelt, however, is visibly polarized more strongly perpendicular to the nanobelt (part 

a, left), as expected based on the previous study of resonant nanobelt scattering in Section 

3.2. In both cases, the emission is highly polarized along the nanobelt length. This 

confirms that the light imaged at the distal end is not simply scattered from the 

illumination beam spot or from the excitation end, since it would either be polarized 

perpendicular to the nanobelt or be unpolarized. Emission polarization along the nanobelt 

length suggests that the plasmon propagation is primarily due to the fundamental mode 

(m=0) where the sign of the charge has no azimuthal angle dependence. As predicted, the 

difference between the two polarizations in the longer belt is less than the difference of 

the two in the shorter belt.  

For belts of this geometry, the calculated cross-over for the m=1 mode to dominate 

should happen at over 7.6µm (Figure 52). Highly uniform nanobelts of this length are 

difficult to find, but a comparison of the polarized emission signals from nanobelts at 

several lengths reveals that the ratio of parallel to perpendicular light emitted at the 

nanobelt tip decreases exponentially as predicted by the simulations (Figure 55c).  An 

exponential fit of these data give a cross-over length of 7.7µm, which is in very good 

agreement with the FDTD calculation shown in Figure 52, considering error and 

geometric heterogeniety. 
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Figure 55 a) Plasmon propagation through a gold nanobelt for scattering and emission polarizations 
perpendicular (blue) and parallel (red) to the belt. (scale bar = 1µm) b) The ratio of the parallel to 
perpendicular components of the emission for several nanobelts. 

 

 

3.5.5 Confinement of Energy 

 

For further insight into the propagation lengths of the m = 0 and m = 1 modes, their 

cross-sectional field intensity and corresponding heat distribution were calculated by 

FDTD (Figure 56). The m = 0 mode generates higher intensity fields than the m = 1 

mode, but most of the m=1 field intensity is localized outside the nanobelt in the 

dielectric medium. The loss is mostly due to heat generation due to the field just inside 

the metal, which can be difficult to predict based on static charge distributions like Figure 
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52d. However, the heat plots in Figure 56 make it clear that the m = 0 mode also has 

higher losses, especially near the metal’s surface, where the field intensity is highest. This 

is why the m=0 mode has a shorter propagation length than the m = 1 mode. 

     

Figure 56 Cross sections of intensity (left) and heat distribution (right) in a 125 x 40 nm gold nanobelt for 
both the m=0 and m=1 modes. Arbitrary Units, Scale bar = 20nm. 

 

   Note that all simulations were done for nanobelts with infinitely sharp corners, which 

is not physically realistic. Not having the measurement sensitivity to measure the corner 

curvature, all calculations were repeated on a nanobelt with a realistic corner radius of 

4nm. It was seen that accounting for curvature made less than 10% difference in the 

propagation length, and since it lowers both the mode area and the propagation length, 

the figure of merit was relatively unchanged. 

   For plasmonic waveguides there is a trade-off between high field confinement, which 

strengthens interactions with nearby emitters, and propagation length, which is important 

for transmitting information.114 As the cross-sectional diameter decreases, the field 

confinement increases due to tighter localization of the electromagnetic field, but the 

propagation length decreases due to an increased fraction of the field being present inside 
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the metal. For 2D strip waveguides a figure of merit (FOM) was proposed by Buckley et 

al that accounts for both confinement and propagation length: 115 

!!
!! = 2 !

!!
!!"#!     (12) 

The mode area Ae is defined as the area bounded by the closed 1/e field magnitude 

contour relative to the electric field maximum, and Lprop is the propagation length. The m 

= 1 mode has a higher FOM than the m = 0 mode for the studied gold nanobelt because 

the former has a Lprop of ~17.5 µm (fitted from Figure 52e), which is about 9 times larger 

than the m=0 propagation length, while they have comparable mode areas. The calculated 

figure of merit for m = 1 mode is ~1300, better than those reported for microns wide strip 

waveguides (~300) at the wavelength of interest (850 nm).115 The strip waveguides were 

microns in width, so they have longer plasmon propagation lengths, but lower 

confinement. Simulations of other subwavelength-sized waveguide architectures at 

telecom wavelengths have reported maximum figures of merit of ~240 for slot 

waveguides 116 and ~1000 for gold rectangular waveguides in InGaAsP. 117, 118  The 

maximum FOM of dielectric-loaded waveguides operating at 780nm has been reported as 

~400.119 Another common definition of figure of merit for nanoscale waveguides is the 

ratio of the propagation length to the effective mode diameter. This FOM is simply a 

factor of 4 smaller than the one defined above. Converting these values, our figure of 

merit exceeds the calculated values for metal-coated hollow nanowires (~800) 120 and 

silver nanowires exhibiting substrate-coupled modes (~360). 121 

When strong coupling interactions with nearby structures are desired, the mode area is 

of primary importance. The mode area for the 125 x 40 nm nanobelt is calculated to be 
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around 2400 nm2, which is only 48% of its cross-sectional area and is roughly two orders 

of magnitude smaller than the mode area of the larger strip waveguides. Our calculations 

also show that a 100 nm diameter cylindrical silver nanowire, as a comparison, has a 

mode area of around 10,300 nm2 (131% of its cross-sectional area). The improved strong 

confinement achieved with gold nanobelts may be useful for studying interactions 

between plasmons and quantum emitters – bridging the gap between plasmonic and 

quantum systems. 

3.5.6 Spectral Emission Properties 

 

To the spectral properties of the propagating plasmon modes were characterized. The 

850 nm LED was replaced by white light from a fiber coupled halogen lamp. A color 

image of the nanobelt taken in epi-illumination bright field is presented in Figure 57a, 

which shows a nanobelt with a scattering plasmon resonance near the middle of the 

visible spectrum (green/yellow). The white light was focused at one end where strong 

yellow scattering was observed, but the faint emission observed at the opposite end was 

red, as seen in Figure 57b. The emission was sent through a microspectrometer. The 

resulting spectra, plotted in Figure 57c, was corrected for the spectral efficiency of the 

instrument with a 2 µm silver colloid as a white scattering standard. The spectral 

emission reveals that the plasmon propagation is most efficient in the near infrared, with 

the majority of the emission beyond a wavelength of 750 nm. The inset to Figure 57c 

displays the emission spectrum magnified to reveal that there is detectable propagation at 

visible frequencies and that there is some structure in the spectrum. Note that in the gold 

nanobelts, a very smooth spectral curve was seen with no evidence of Fabry-Perot fringes 
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that are often seen in silver nanowires.56, 107, 108, 110, 112, 122 This may be attributed to the 

reduced propagation length in these thin gold nanostructures. 

 

Figure 57 Spectral properties of plasmon propagation in gold nanobelts. A color image a) under wide field 
white light illumination and b) under propagation c) The emission spectrum strongly favors near infrared 
wavelengths and the inset displays some structure in the visible. 
 

To compare, the analytical model for cylindrical nanowires was solved as a function of 

wavelength for three different wire diameters. The result of the calculation, plotted in 

Figure 58, captures the spectral effect of intrinsic propagation loss, but ignores possible 

spectral influence of absorption and scattering geometry of the nanobelt ends. Still, given 

these limitations, the predicted emission spectra are very similar to Figure 57c with a 

strong increase in propagation efficiency with wavelength, although they do so at shorter 

wavelengths. The calculations show that the wavelength where the emission rapidly 
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increases is sensitive to the size, so it is not surprising that it is also apparently sensitive 

to cross-sectional shape. 

 

Figure 58 Calculated plasmon propagation spectra for gold nanowires with given diameters. 

3.5.7 Conclusion 

 

In summary, plasmon propagation in thin gold nanobelts has been directly 

observed in gold nanobelts by focusing light at one end and imaging the emission from 

the other. Problems with imaging short propagation lengths and weak emission signals 

were overcome through the use of low coherence LED illumination. Propagation was 

found to be highly efficient in the near-infrared, where gold is minimally lossy. Emission 

measurements from multiple nanobelts were scaled for different sizes with the scattering 

signal from the nanobelt excitation end to reveal the average propagation length of the 

fundamental propagating mode to be 0.94 µm at a wavelength of 850 nm. The 

propagation was also found to strongly favor near infrared frequencies, agreeing with an 

analytical model of a cylindrical gold nanowire. 



 85 

 

  

FDTD calculations and experiments show that the measurement is dominated by 

the fundamental propagating mode, but with increasing nanobelt length, a higher-order 

mode begins to dominate. This m=1 mode has a propagation length of 17.5 µm and a 

figure of merit of 1300, the highest reported for nanoscale plasmonic waveguides. The 

high confinement factor for these structures represent an important step towards studying 

strong interactions of propagating plasmons with nearby quantum emitters, given the 

reduced cross-sectional size and the facile surface chemistry of gold nanobelts. Future 

studies attempting selective mode in-coupling via nearby antennas and photon sources 

would be of great interest.  

 

. 
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 Conclusion 

 Nobel metal plasmonic structures have been studied for their properties that may 

be useful in various medical and information-processing applications. By quantifying 

individual nanoparticle scattering cross sections in a dark field microscope, it was found 

that certain nanoparticle geometries scatter very brightly for their volume. This finding 

may prove valuable in imaging applications that require highly efficient scatterers that 

can permeate into small spaces.  

Novel elongated plasmonic structures, gold nanobelts, have been shown to support a 

strong and highly tunable transverse standing mode as well as longitudinal propagating 

modes. The transverse mode is bright and narrow and its peak position varies linearly 

with the cross-sectional aspect ratio of the nanobelt (width/height).  The nanobelts 

measured have transverse resonances that traverse much of the visible spectrum. 

Longitudinal plasmons were launched in gold nanobelts using a tightly focused 850nm 

LED source. The average measured propagation length for these nanobelts is 940nm. For 

small cross section elongated nanostructures, the fundamental, azimuthally symmetric 

mode is dominant. It has been found, however, that a higher-order mode exists that 

decays more slowly and therefore begins to dominate at longer lengths. The polarization 

of the gold nanobelt emission was characterized and shows this trend, which is supported 

by FDTD simulations.  

Gold nanobelts have the smallest cross section of any elongated plasmonic structure 

that has been shown to support longitudinal propagating plasmon modes. The m=1 

propagating mode has the highest figure of merit reported for a nanoscale plasmonic 

waveguide. Because of their small size, nanobelts tightly confine electromagnetic energy, 
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an important step towards strong coupling between plasmonic structures and objects that 

are small enough to display quantum behaviors. 
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 Appendix 

Appendix A: Matlab Code, Mie Solution  

Calculating σtot and σobj 

 
clear 
%input nanosphere radius 
din=input('diameter in nm? ','s'); 
%radius=diameter/2 
rad=str2num(din)/2; 
r=rad*1e-9; 
load gold_diel2 
nm=1.515; 
n=gold_dielectric2(:,2); 
k=gold_dielectric2(:,3); 
%input angular detection range 
%minimum detection angle (radians) 
thetaMin=3.2909; 
%maximum detection angle (radians) 
thetaMax=3.9635; 
%phi range = theta range 
phi=thetaMax-thetaMin; 
for t=1:600; 

w(t)=t+400; 
m=(n(t)+i*k(t))/nm; %ratio of indecies of refraction particle/medium 
l=t+400; %wavelegth (nm) 
kn=(2*pi*nm)/(l*10^(-9)); %wavenumber 
x=kn*r; 
%getting "a" and "b" (L is the multipole order) 
for L=1:9 

psix=sqrt((pi*x)/2)*besselj(L+(1/2),x); 
psix2=sqrt(pi/2)*(((L+1)/sqrt(x))*besselj(L+(1/2),x)-

(sqrt(x)*besselj(L+(3/2),x))); 
psimx=sqrt(pi*m*x/2)*besselj(L+(1/2),m*x); 
psimx2=sqrt(pi/2)*(((L+1)/sqrt(m*x))*besselj(L+(1/2),m*x)-
(sqrt(m*x)*besselj(L+(3/2),m*x))); 
ksix=sqrt(pi*x/2)*besselh(L+(1/2),x); 
ksix2=sqrt(pi/2)*(((L+1)/sqrt(x))*besselh(L+(1/2),x)-

(sqrt(x)*besselh(L+(3/2),x))); 
ksimx=sqrt(pi*m*x/2)*besselh(L+(1/2),m*x); 
ksimx2=sqrt(pi/2)*(((L+1)/sqrt(m*x))*besselh(L+(1/2),m*x)-
(sqrt(m*x)*besselh(L+(3/2),m*x))); 
a(L)=(m*psimx*psix2-psix*psimx2)/(m*psimx*ksix2-ksix*psimx2); 
b(L)=(psimx*psix2-m*psix*psimx2)/(psimx*ksix2-m*ksix*psimx2); 
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S(L)=(2*pi/(kn^2))*(2*L+1)*(abs(a(L))*(abs(a(L)))+(abs(b(L)))*(abs(b(L))));  

end %end L-loop 
  

%total scattering cross section: 
scaap(t)=(S(1)+S(2)+S(3)+S(4)+S(5)+S(6)+S(7)+S(8)+S(9)); 
%Find peak amplitude of scattering to the objective: 
MaxTotal=max(scaap); 

  
%angular loop 
dTheta = .0001; 
numSteps=(thetaMax-thetaMin)/dTheta; 
clear theSum; 
theSum = 0; 
for ii=1:numSteps; 

theta = thetaMin + ii*dTheta; 
%Calculate the scattering parameters tau and pi 
%initial conditions on pi 
pi1=1; 
pi2=3*cos(theta); 
pi3=(5/2)*cos(theta)*pi2-(3/2)*pi1; 
pi4=(7/3)*cos(theta)*pi3-(4/3)*pi2; 
pi5=(9/4)*cos(theta)*pi4-(5/4)*pi3; 
pi6=(11/5)*cos(theta)*pi5-(6/5)*pi4; 
pi7=(13/6)*cos(theta)*pi6-(7/6)*pi5; 
  
tau1=cos(theta); 
tau2=6*(cos(theta)*cos(theta))-3; 
tau3=3*cos(theta)*pi3-4*pi2; 
tau4=4*cos(theta)*pi4-5*pi3; 
tau5=5*cos(theta)*pi5-6*pi4; 
tau6=6*cos(theta)*pi6-7*pi5; 
  
%some scattering parameters that depend on tau, pi, a and b 
S101=(3/2)*(a(1)*pi1+b(1)*tau1); 
S102=(5/6)*(a(2)*pi2+b(2)*tau2); 
S103=(7/12)*(a(3)*pi3+b(3)*tau3); 
S104=(9/20)*(a(4)*pi4+b(4)*tau4); 
S105=(11/30)*(a(5)*pi5+b(5)*tau5); 
S106=(13/42)*(a(6)*pi6+b(6)*tau6); 
S1=S101+S102+S103+S104+S105+S106; %sum of 6 terms above 
  
S201=(3/2)*(a(1)*tau1+b(1)*pi1); 
S202=(5/6)*(a(2)*tau2+b(2)*pi2); 
S203=(7/12)*(a(3)*tau3+b(3)*pi3); 
S204=(9/20)*(a(4)*tau4+b(4)*pi4); 



 95 

 

  

S205=(11/30)*(a(5)*tau5+b(5)*pi5); 
S206=(13/42)*(a(6)*tau6+b(6)*pi6); 
S2=S201+S202+S203+S204+S205+S206; %sum of 6 terms above 
  
  
S11=.5*(abs(S2)*abs(S2)+abs(S1)*abs(S1)); 
ds_dt=S11/(kn*kn); 
  
theSum = theSum + abs(ds_dt*sin(theta)) * dTheta; 

  
end 
%Scattering cross section for wavelength t over the solid angle of the 
%detector: 
scatter(t)=phi*theSum;  

end 
  
%Find peak amplitude of scattering to the objective: 
MaxDiff=max(scatter); 
  
%Find peak wavelength: 
temporary=scatter; 
for ii=1:600                           
         if MaxDiff==temporary(ii) 
             peakpsc=ii; 
         end 
     end 
peak_wavelength_sc=peakpsc+400; 
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Appendix B: Matlab Code, Approximations to Mie Solution 

Comparing σtot (dipole term only, small particle approximation, Gans solution) 

 
clear 
%Calculate the extinction, absorption, and scattering from a gold sphere or 
%ellipsoid using Mie or Gans theory (Gan's is in the small particle limit). 
load gold_diel 
n2=input('Medium index of refraction (n)?','s'); 
nm=str2num(n2); 
em=nm^2; 
type=input('Would you like to model a sphere or an ellipsoid? (sphere=0, 
ellipsoid=1):','s'); 
model=str2num(type); 
  
%sphere 
if model==0 
    rad=input('Sphere radius (in nm): ','s'); 
    rd=str2num(rad); 
    r=rd*10^(-9);  %nanoparticle radius in nanometers 
    small=input('Is ka<<1? (yes(1) or no(0)): '); 
  
%Full Mie expression 
    if small==0 
        for P=1:10 
            for t=1:2400 
                l=(.25)*t+400; 
                n=gold_dielectric(:,2); 
                k=gold_dielectric(:,3); 
                m=(n(t)+i*k(t))/nm; 
                kn=(2*pi*nm)/(l*10^(-9)); 
                x=kn*r; 
                psix=sqrt((pi*x)/2)*besselj(P+(1/2),x); 
                psix2=sqrt(pi/2)*(((P+1)/sqrt(x))*besselj(P+(1/2),x)-
(sqrt(x)*besselj(P+(3/2),x))); 
                psimx=sqrt(pi*m*x/2)*besselj(P+(1/2),m*x); 

    psimx2=sqrt(pi/2)*(((P+1)/sqrt(m*x))*besselj(P+(1/2),m*x)-
(sqrt(m*x)*besselj(P+(3/2),m*x))); 

                ksix=sqrt(pi*x/2)*besselh(P+(1/2),x); 
                ksix2=sqrt(pi/2)*(((P+1)/sqrt(x))*besselh(P+(1/2),x)-
(sqrt(x)*besselh(P+(3/2),x))); 
                ksimx=sqrt(pi*m*x/2)*besselh(P+(1/2),m*x); 

     ksimx2=sqrt(pi/2)*(((P+1)/sqrt(m*x))*besselh(P+(1/2),m*x)-
(sqrt(m*x)*besselh(P+(3/2),m*x))); 

                a=(m*psimx*psix2-psix*psimx2)/(m*psimx*ksix2-ksix*psimx2); 
                b=(psimx*psix2-m*psix*psimx2)/(psimx*ksix2-m*ksix*psimx2); 
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                S(P,t)=(2*pi/(kn^2))*(2*P+1)*((abs(a))^2+(abs(b))^2); 
                E(P,t)=(2*pi/(kn^2))*(2*P+1)*real(a+b); 
                w(t)=(.25)*t+399; 
            end %end t-loop 
        end %end P-loop 
        scaap=(S(1,:)+S(2,:)+S(3,:)+S(4,:)+S(5,:)+S(6,:)+S(7,:)+S(8,:)+S(9,:)+S(10,:)); 
        extap=(E(1,:)+E(2,:)+E(3,:)+E(4,:)+E(5,:)+E(6,:)+E(7,:)+E(8,:)+E(9,:)+E(10,:)); 
        absap(t)=extap(t)-scaap(t); 
    end %end if small==0 
  
%Small particle approximation 
    if small==1 
        for t = 1:2400 
            n=gold_dielectric(:,2); 
            k=gold_dielectric(:,3); 
            ep(t)=n(t)*n(t)-k(t)*k(t); 
            epp(t)=2*n(t)*k(t); 
            lambda(t)=((.25)*t+400)*10^(-9); 
            scoeff(t)=(128*pi*pi*pi*pi*pi*em*em*r*r*r*r*r*r)/(3*(lambda(t)^4)); 
            ecoeff(t)=(24*pi*pi*r*r*r*(em^(3/2)))/lambda(t); 

scaap(t)=scoeff(t)*(((ep(t)-em)*(ep(t)-
em))+(epp(t)*epp(t)))/(((ep(t)+2*em)*(ep(t)+2*em))+ (epp(t)*epp(t))); 

              
extap(t)=ecoeff(t)*(epp(t)/(((ep(t)+2*em)*(ep(t)+2*em))+(epp(t)*epp(t)))); 

             
absap(t)=extap(t)-scaap(t); 

             
w(t)=(.25)*t+399; 

        end %end t-loop 
     end %end if small==1 
end %end if model=0 
  
       
if model==1  
    maj=input('Major radius (in nm): ','s'); 
    a0 = str2num(maj); 
    min=input('Minor radius (in nm): ','s'); 
    a1 = str2num(min); 
    a=a0*10^(-9);  %nanoparticle major radius in nanometers 
    b=a1*10^(-9);  %nanoparticle minor radius in nanometers 
    V=4*pi*a*b*b/3; 
    eccen=sqrt(1-(b/a)^2); 
    Pa=(1/eccen^2 -1)*((1/(2*eccen))*(log((1+eccen)/(1-eccen)))-1); 
    Pb=(1-Pa)/2; 
    Pc=Pb; 
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    for L = 1:3 
        for t = 1:2400 
            n=gold_dielectric(:,2); 
            k=gold_dielectric(:,3); 
            ep(t)=n(t)*n(t)-k(t)*k(t); 
            epp(t)=2*n(t)*k(t); 
            lambda=(.25)*t+400; 

extap(t)=10^9*18*pi*(em)^(3/2)*V*(1/Pa^2)*epp(t)/(lambda*((ep(t)+(1/Pa - 
1)*em)^2+(epp(t))^2))   +   
10^9*18*pi*(em)^(3/2)*V*(1/Pb^2)*epp(t)/(lambda*((ep(t)+(1/Pb - 
1)*em)^2+(epp(t))^2))  +  
10^9*18*pi*(em)^(3/2)*V*(1/Pc^2)*epp(t)/(lambda*((ep(t)+(1/Pc - 
1)*em)^2+(epp(t))^2)); 

            scaap(t)=10^36*8*pi^3*em^2*V^2*(1/Pa^2)*((ep(t)-
em)^2+(epp(t))^2)/(3*lambda^4*((ep(t)+(1/Pa-1)*em)^2+(epp(t))^2))   +   
10^36*8*pi^3*em^2*V^2*(1/Pb^2)*((ep(t)-
em)^2+(epp(t))^2)/(3*lambda^4*((ep(t)+(1/Pb-1)*em)^2+(epp(t))^2))  +   
10^36*8*pi^3*em^2*V^2*(1/Pc^2)*((ep(t)-
em)^2+(epp(t))^2)/(3*lambda^4*((ep(t)+(1/Pc-1)*em)^2+(epp(t))^2)); 
            absap(t)=extap(t)-scaap(t); 
            w(t)=(.25)*t+400; 
        end %end t-loop 
    end %end L-loop 
end %end model=1 
  
%Find the peak height and peak wavelength 
Maximum=max(scaap); 
temporary=scaap; 
for ii=1:2400                           
    if Maximum==temporary(ii) 
       peakp=ii; 
    end 
end 
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Appendix C: Matlab Code, Spectral Analysis and Calculation of K 

Analyzing Spectra and Calculating Kλ 

 
clear 
  
load Mie; %load angular mie result 
load std; %load spectral wavelength values 
  
%Create wavelength values 400-1000nm 
for t=1:600 
    w(t)=t+400; 
end 
  
%Analyze spectral data: 
  
%Find the file and save the filename and path 
[file,path]=uigetfile('*','Select the image to analyze'); 
  
%Load the image 
ve = imread([path,file],'tiff'); 
     
%convert integers to floating point numbers 
ve = double(ve); 
  
%flip the image upside down so orientation appears same as original   
for i = 1:512 
    for j = 1:512 
            vd(i,j)=ve(513-i,j); 
    end 
end 
%Plot the image to specify particle location and width 
    figure 
    drawnow 
    pcolor(vd) 
    shading interp 
  
st = input('Based on the image, enter the pixel of the spectrum center:  ','s'); 
center=str2num(st); 
  
st1 = input('What width (in pixels) do you want to sum over?  ','s'); 
 width = str2num(st1); 
     
dt =input('What is the integration time of the image? ','s'); 
 time=str2num(dt);  
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%isolate data in this range (where the particle is) 
v1raw=vd(:,(center-width):(center+width)); 
%sum the sqrt of the data in this range to get the error for each 
%wavelength 
for i = 1:512 
    error(i)=sum(sqrt(vd(i,center-width:center+width))/(time)); 
end 
  
  
%create x-axis: spatial values 
x=1:512; 
x((center-width):(center+width))=[]; 
%subtract particle out of data (for bkg fit) 
vd(:,(center-width):(center+width))=[]; 
plot(x,vd(:,:)) 
  
%choose range to fit background (in pixel values)  
  rl=input('Lower bound on background fit? ','s'); 
   range1 = str2num(rl); 
  ru=input('Upper bound on background fit? ','s'); 
   range2=str2num(ru); 
   
for ii=1:(512-((2*width)+1)) 
    if x(ii)==range1 
        r1=ii; 
    end 
    if x(ii)==range2 
        r2=ii; 
    end 
end %end ii-loop 
 vd=vd(:,(r1+1):(r2-1)); 
 %Take out edges and change the x-axis accordingly 
 x(r2:(512-((2*width)+1)))=[]; 
 x(1:r1)=[]; 
  
N=input('What order polynomial would you like to fit the background to?' ); 
  
for i=1:512%(each wavelength) 
    drawnow 
    plot(x,vd(i,:)) 
    hold on 
    %for each wavelength, fit a curve to vd(signal-paricle) as a function of 
    %space 
    P=polyfit(x,vd(i,:),N); 
    for ii=1:(r2-1-r1)%each spatial value 
        %Nth order 
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        for j=1:N+1 
            vb2(j)=P(j)*x(ii)^(N-(j-1)); 
        end %j-loop 
        %The background as a function of spatial pixel values. (there is one of 
        %these for each wavelength 
        vb(i,ii)=sum(vb2); 
    end %ii-loop 
    %extend vb to include the center (actually, entire spatial axis) 
    for jj=1:512 
         for j=1:N+1 
            back(j)=P(j)*(jj)^(N-(j-1)); 
         end  
         bkg(i,jj)=sum(back); 
    end %jj-loop 
    
    plot(x,vb(i,:)) 
    hold off 
end %i-loop 
  
    bkgd=(bkg(:,center-width:center+width));  
  
for i=1:512 
    for j=1:2*width+1 
        tot(i,j)=v1raw(i,j)-bkgd(i,j); 
    end 
    v1(i)=sum(tot(i,:))/(time); 
end 
  
v1=v1'; 
Maxv1=max(v1); 
newv1=interp1(spswavelengths,v1,w); 
newerv1=(1/1.945)*newv1; 
newerv1=newerv1'; 
 
%Solve for K  
for i=1:600 
    K(i)=newerv1(i)/scatter(i); 
end 
  
error=error'; 
plot(spswavelengths,v1) 
plot(w,K) 
K=K'; 
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Appendix D: COMSOL Multiphysics Simultation 

 Gold nanobelt dimers were simulated using the commercially available software 

package, COMSOL. This software uses the widely known Finite Element Method, which 

finds numerical solutions to partial differential equations (in this case, the equations of 

electrodynamics). The method relies on dividing up the simulation space into small 

pieces and solving the equations in each of these elements in relation to one another. The 

solutions of a PDE are approximated by solutions to an ODE in the time-varying case, 

and an algebraic equation in the steady-state case. This is vast a simplification over 

solving the complex problem everywhere in the simulation space, and is known to give 

accurate answers. 

 For the simulation of two parallel gold nanobelts, it is sufficient to do a 2D cross 

section of the actual 3D problem, and is actually superior to a 3D simulation. The full 3D 

simulation is very computationally expensive, and does not realistically allow for 

microns-long nanobelt lengths given the computational limits. This leaves the option of 

simulating nanobelts that are shorter than the experimental nanobelts, say a few microns 

or less. This poses problems because, at this length scale, standing plasmon modes can 

form longitudinally, resulting in a longitudinal resonance, which is not true in the 

experimental case; in reality, the nanobelts are too long for a standing longitudinal 

resonance to form. The 2D simulation solves this problem perfectly because a 2D cross 

section treats the belts as infinite, which they essentially are, in comparison to their cross-

sectional dimensions. 

Opening the COMSOL Multiphysics package, the user is presented with a Model 

Navigator window (Figure 59). Under “Space Dimension”, 2D should be selected from 
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the drop-down box. For electrostatics problems, the RF module is used. We are interested 

in an incident plane wave that is normal to the nanobelt dimer and polarized 

perpendicular to the belts (across the gap). We will choose the “Perpendicular Waves” 

module, and under that, “TM waves” (Figure 59).  

  

Figure 59 Model Navigator in COMSOL Multiphysics. 

 

 Upon clicking “OK”, the COMSOL Module will open. First, we want to create all 

of the geometric objects, this will include the nanobelts, the simulation space and a 

“perfectly matched layer” (PML). The PML is an artificial absorbing layer that is 

commonly used in wave simulations with open boundaries to eliminate reflections at the 

imposed boundary. For adding geometry, we want to be in “Draw Mode”. There should 

be a button with a small pencil: , once pressed the user is in this mode. There will be a 

number of drawing tools, for which the placement may vary depending on the software 
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version and operating system. To create the rectangular nanobelt cross sections, we will 

click the rectangle button ( ). By dragging the cursor in the simulation space, we will get 

a rectangle whose properties can be manipulated by going to Draw -> Object Properties. 

For the simulation results shown in Section 3.4, the nanobelt size was 50nm x 20nm. To 

have the dimer gap in the center of the simulation space, we also shift the first belt 

position ( 

Figure 60). Note that the “zoom extents” button  will zoom to make the current 

geometric objects fill up the field of view. 

 
 

Figure 60 Specifying the nanobelt geometry in COMSOL. 
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We repeat the last step to make the second nanobelt, with the only difference being in the 

position. The x coordinate of the rectangle bases should be at ±(nanobelt width + gap 

size)/2.  

 The FEM method has difficulty solving in domains with sharp corners – which 

are also not realistic. We therefore, give the nanobelt corners a slight curvature. To do 

this, we click the “Fillet/Chamfer” button in Draw Mode: . The pop-up window will 

give all corners in the simulation, which at this point are the nanobelt corners. They 

should all be selected and a small, realistic radius of curvature should be specified, in this 

case, we chose 2nm ( 

Figure 61). 
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Figure 61 Rounding the nanobelt corners in COMSOL 

  

Next, we will create an outer boundary for the space and a PML layer. By clicking 

the “ellipse/circle (centered)” button in Draw Mode, and modifying the object properties, 

as above, two circles should be created: an outer boundary (r=750nm is more than 

sufficient) and an inner boundary where the PML will start (r=550nm, in this case). Our 

simulation space and PML will be simply the dielectric of oil, but the frequency-

dependent dielectric function of the gold nanobelts is more complicated and can be 

manually defined for COMSOL via a text file as follows: 

lib.version.name='COMSOL 3.4'; 
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lib.version.ext=''; 

lib.name='User Materials'; 

lib.descr=''; 

lib.mat{1}.name='Gold (J&C)'; 
lib.mat{1}.variables.nu='0.44'; 
lib.mat{1}.variables.epsilonr='jcEpsReal(nu_rfweh)'; 
lib.mat{1}.variables.rho='19300[kg/m^3]'; 
lib.mat{1}.variables.E='78e9[Pa]'; 
lib.mat{1}.variables.C='129[J/(kg*K)]'; 
lib.mat{1}.variables.sigma='2*pi*epsilon0_rfweh*nu_rfweh*jcEpsImag(nu_rfweh)'; 
lib.mat{1}.variables.alpha='14.2e-6'; 
lib.mat{1}.variables.n='jcN(nu_rfweh)+j*jcK(nu_rfweh)'; 
lib.mat{1}.variables.T0='298.15[K]'; 
lib.mat{1}.variables.k='316[W/(m*K)]'; 
clear fcns 
fcns{1}.type='interp'; 
fcns{1}.name='jcEpsReal'; 
fcns{1}.method='linear'; 
fcns{1}.extmethod='extrap'; 
fcns{1}.x={'1.5475131e+14','1.8618517e+14','2.1520105e+14', ... 
  '2.4663491e+14','2.7565078e+14','3.0466665e+14','3.3610051e+14', ... 
  '3.6511638e+14','3.9655024e+14','4.2556611e+14','4.5458199e+14', ... 
  '4.8601585e+14','5.1503172e+14','5.4646558e+14','5.7548145e+14', ... 
  '6.0449732e+14','6.3593118e+14','6.6494705e+14','6.9638091e+14', ... 
  '7.2539679e+14','7.5441266e+14','7.8584652e+14','8.1486239e+14', ... 
  '8.4629625e+14','8.7531212e+14','9.0432799e+14','9.3576185e+14', ... 
  '9.6477772e+14','9.9621159e+14','1.0252275e+15','1.0542433e+15', ... 
  '1.0856772e+15','1.1146931e+15','1.1461269e+15','1.1751428e+15', ... 
  '1.2041587e+15','1.2355925e+15','1.2646084e+15','1.2960423e+15', ... 
  '1.3250581e+15','1.354074e+15','1.3855079e+15','1.4145237e+15', ... 
  '1.4459576e+15','1.4749735e+15','1.5039893e+15','1.5354232e+15', ... 
  '1.5644391e+15','1.5958729e+15'}; 
fcns{1}.data={'-189.042','-125.3505','-90.426461','-66.218525','-51.0496', ... 
  '-40.2741','-32.040669','-25.811289','-20.610164','-16.817709', ... 
  '-13.648209','-10.661884','-8.112669','-5.842125','-3.946161', ... 
  '-2.278289','-1.702701','-1.758996','-1.692204','-1.702164','-1.649404', ... 
  '-1.604889','-1.400625','-1.231956','-1.310241','-1.169489','-1.230804', ... 
  '-1.242549','-1.227421','-1.306784','-1.332261','-1.366509','-1.346409', ... 
  '-1.236501','-1.080444','-0.891261','-0.744529','-0.616896','-0.551009', ... 
  '-0.4155','-0.346329','-0.233769','-0.1325','-0.010416','0.138171', ... 
  '0.203899','0.292524','0.295191','0.227056'}; 
fcns{2}.type='interp'; 
fcns{2}.name='jcEpsImag'; 
fcns{2}.method='linear'; 
fcns{2}.extmethod='extrap'; 
fcns{2}.x={'1.5475131e+14','1.8618517e+14','2.1520105e+14', ... 
  '2.4663491e+14','2.7565078e+14','3.0466665e+14','3.3610051e+14', ... 
  '3.6511638e+14','3.9655024e+14','4.2556611e+14','4.5458199e+14', ... 
  '4.8601585e+14','5.1503172e+14','5.4646558e+14','5.7548145e+14', ... 
  '6.0449732e+14','6.3593118e+14','6.6494705e+14','6.9638091e+14', ... 
  '7.2539679e+14','7.5441266e+14','7.8584652e+14','8.1486239e+14', ... 
  '8.4629625e+14','8.7531212e+14','9.0432799e+14','9.3576185e+14', ... 
  '9.6477772e+14','9.9621159e+14','1.0252275e+15','1.0542433e+15', ... 
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  '1.0856772e+15','1.1146931e+15','1.1461269e+15','1.1751428e+15', ... 
  '1.2041587e+15','1.2355925e+15','1.2646084e+15','1.2960423e+15', ... 
  '1.3250581e+15','1.354074e+15','1.3855079e+15','1.4145237e+15', ... 
  '1.4459576e+15','1.4749735e+15','1.5039893e+15','1.5354232e+15', ... 
  '1.5644391e+15','1.5958729e+15'}; 
fcns{2}.data={'25.3552','12.5552','8.18634',' 5.7015','  3.861','  2.794', ... 
  '1.92542','1.62656','1.27176','1.06678','1.03516','1.37424','1.66054', ... 
  ' 2.1113','2.58044','3.81264','4.84438','5.28264',' 5.6492','5.71736', ... 
  '5.73888','5.64436',' 5.6092','  5.598','5.53816','5.42568','5.84584', ... 
  '5.79258','5.78034','5.59644','5.49486','5.28242','4.97628',' 4.7223', ... 
  '4.49008','4.33846','4.16328','4.05504',' 3.8922',' 3.8252',' 3.7102', ... 
  ' 3.6062','   3.51',' 3.3904','3.39682','3.32766','3.28568','3.17592', ... 
  '3.04128'}; 
fcns{3}.type='interp'; 
fcns{3}.name='jcN'; 
fcns{3}.method='linear'; 
fcns{3}.extmethod='extrap'; 
fcns{3}.x={'1.5475131e+14','1.8618517e+14','2.1520105e+14', ... 
  '2.4663491e+14','2.7565078e+14','3.0466665e+14','3.3610051e+14', ... 
  '3.6511638e+14','3.9655024e+14','4.2556611e+14','4.5458199e+14', ... 
  '4.8601585e+14','5.1503172e+14','5.4646558e+14','5.7548145e+14', ... 
  '6.0449732e+14','6.3593118e+14','6.6494705e+14','6.9638091e+14', ... 
  '7.2539679e+14','7.5441266e+14','7.8584652e+14','8.1486239e+14', ... 
  '8.4629625e+14','8.7531212e+14','9.0432799e+14','9.3576185e+14', ... 
  '9.6477772e+14','9.9621159e+14','1.0252275e+15','1.0542433e+15', ... 
  '1.0856772e+15','1.1146931e+15','1.1461269e+15','1.1751428e+15', ... 
  '1.2041587e+15','1.2355925e+15','1.2646084e+15','1.2960423e+15', ... 
  '1.3250581e+15','1.354074e+15','1.3855079e+15','1.4145237e+15', ... 
  '1.4459576e+15','1.4749735e+15','1.5039893e+15','1.5354232e+15', ... 
  '1.5644391e+15','1.5958729e+15'}; 
fcns{3}.data={'0.92','   0.56','   0.43','   0.35','   0.27','   0.22', ... 
  '0.17','   0.16','   0.14','   0.13','   0.14','   0.21','0.29', ... 
  '   0.43','   0.62','   1.04','   1.31','   1.38','1.45','   1.46', ... 
  '   1.47','   1.46','   1.48','    1.5','1.48','   1.48','   1.54', ... 
  '   1.53','   1.53','   1.49','1.47','   1.43','   1.38','   1.35', ... 
  '   1.33','   1.33','1.32','   1.32','    1.3','   1.31','    1.3', ... 
  '    1.3','1.3','    1.3','   1.33','   1.33','   1.34','   1.32', ... 
  '   1.28'}; 
fcns{4}.type='interp'; 
fcns{4}.name='jcK'; 
fcns{4}.method='linear'; 
fcns{4}.extmethod='extrap'; 
fcns{4}.x={'1.5475131e+14','1.8618517e+14','2.1520105e+14', ... 
  '2.4663491e+14','2.7565078e+14','3.0466665e+14','3.3610051e+14', ... 
  '3.6511638e+14','3.9655024e+14','4.2556611e+14','4.5458199e+14', ... 
  '4.8601585e+14','5.1503172e+14','5.4646558e+14','5.7548145e+14', ... 
  '6.0449732e+14','6.3593118e+14','6.6494705e+14','6.9638091e+14', ... 
  '7.2539679e+14','7.5441266e+14','7.8584652e+14','8.1486239e+14', ... 
  '8.4629625e+14','8.7531212e+14','9.0432799e+14','9.3576185e+14', ... 
  '9.6477772e+14','9.9621159e+14','1.0252275e+15','1.0542433e+15', ... 
  '1.0856772e+15','1.1146931e+15','1.1461269e+15','1.1751428e+15', ... 
  '1.2041587e+15','1.2355925e+15','1.2646084e+15','1.2960423e+15', ... 
  '1.3250581e+15','1.354074e+15','1.3855079e+15','1.4145237e+15', ... 
  '1.4459576e+15','1.4749735e+15','1.5039893e+15','1.5354232e+15', ... 
  '1.5644391e+15','1.5958729e+15'}; 
fcns{4}.data={'  13.78','  11.21','  9.519','  8.145','   7.15','   6.35', ... 
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  '  5.663','  5.083','  4.542','  4.103','  3.697','  3.272','  2.863', ... 
  '  2.455','  2.081','  1.833','  1.849','  1.914','  1.948','  1.958', ... 
  '  1.952','  1.933','  1.895','  1.866','  1.871','  1.833','  1.898', ... 
  '  1.893','  1.889','  1.878','  1.869','  1.847','  1.803','  1.749', ... 
  '  1.688','  1.631','  1.577','  1.536','  1.497','   1.46','  1.427', ... 
  '  1.387','   1.35','  1.304','  1.277','  1.251','  1.226','  1.203', ... 
  '  1.188'}; 
lib.mat{1}.functions = fcns; 

 

This text file can be uploaded under Options -> Materials/Coefficients Library, then 

clicking the button “Add Library”.  Under Physics -> Subdomain Settings, the nanobelts 

subdomains (2 & 3) should be specified as gold (under the Physics tab), while the other 

subdomains (1 & 4) are defined as n=1.5. For the largest domain (4), under the PML tab, 

we select “Cylindrical” and the other fields will auto-fill. We are now done with 

Subdomain Settings and click “OK”. 

Next, we select Physics -> Boundary Settings. The outmost boundary, which can be 

selected on the left side, or by clicking the lines in the simulation space, must be set to a 

“Scattering boundary condition” with “Plane wave” selected as the “Wave type”. Not that 

it is useful to check the “Select by group” box here. After clicking “OK’, we go to 

Physics -> Application Mode Properties, we want to select “Free Space Wavelength” 

from the “Specify wave using:” drop-down box, then select “OK”.  Under Physics -> 

Scalar Variables, we can specify an incident plane wave. In this case, the incident 

magnetic field is defined as !! = !!
!"#! !

!"#, which will be written as ((exp(-

j*k0_rfweh*y))/((120*pi/(1.5^2))) in the “H0iz_rfweh” field. There is no need to specify 

the wavelength here, as we will override that field in a next step. Under Solve -> Solver 

Parameters (or the  button), we will select the “Parametric” solver from the left 

column and, under the General tab, define the “Parameter Name” as “lambda0_frweh”. 
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Under “Parameter Values”, we define the wavelengths we want to solve for. In this case, 

that is usually just the excitation and emission wavelengths of the particular Raman mode 

being studied, or many more wavelengths in the case of calculating a full spectrum. For 

the “Linear system solver”, we select “Direct (PARADISO)”. “GMRES” is also good if 

the former option will not run on a specific system ( 

Figure 62). 

 
 

Figure 62 Solver Parameters window in COMSOL. 

 
 Next, we will create a mesh. The size of the mesh domains must be sufficiently 

small to get a good solution. For 2D problems, computational power should not be a 

problem and it is quite easy to obtain a good mesh. COMSOL has a complicated 

algorithm for creating the mesh, but we can specify sensitive regions of the simulation for 
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which we want to impose restraints. Under Mesh -> Free Mesh Parameters, we define a 

global “Maximum element size” of 50nm or so, with a Element growth rate of 1.3. Under 

the Subdomain tab, we can specify a very small maximum element size for the nanobelts 

themselves, (~1nm, 1.1 element growth rate is good), and possibly an even smaller size 

on the boundaries in the gap under the Boundaries tab. Under Mesh -> Mesh 

Visualization Parameters, we can check the Element color box and select “Quality” to see 

how good of a mesh we are getting. Now, we Initialize Mesh under the Mesh menu, and 

it will be displayed with a color scale that represents the quality of each element (Figure 

63). 

  

 

 If the mesh quality is sufficient, we are ready to solve. Simply click the  button, 

the solution should take on the order of minutes, depending on how many wavelengths 

are being solved for. When the problem is solved, the “Progress” window will close and 

the solution should be plotted in the space. We have the option of plotting many different 

variables. In this problem, however, we are solely interested in the total electric field. 

Figure 63 The COMSOL mesh with elements rated on their mesh quality from 0 to 1. 
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Under Postprocessing -> Plot Parameters, we select the “Surface” tab and select “Electric 

Field, norm” from the “Predefined quantities” drop-down box. Here we can also 

manipulate other plot properties, such as the color and scale. In this same window, under 

the “General” tab, we can select the wavelength solution we want to use, under the 

“Parameter Value” drop-down box. This gives us a nice color plot of the electric field 

enhancements, like Figure 41 and          Figure 42. For a spectrum of the electric field 

enhancements at a specific point, we select Postprocessing -> Cross section Plot 

Parameters. Under the “General” tab, we select “Point plot”, and make sure all of the 

wavelengths are highlighted in the “Solutions to use” section. We then go to the “Point” 

tab and select “Electric Field, norm” from the “Predefined Quantities” drop-down box 

then define the point (x,y). In this case, the point (0,0) was investigated, as it is centered 

in the gap. Upon clicking “OK”, a spectral plot will be generated, as in Figure 43 and 

Figure 44. 
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Appendix E: Mie Scattering from an Infinite Cylinder 

r(j) = 5e-9; %cylinder radius 
nm = 1.5; %index of refraction (n) of surrounding medium 
n = gold_dielectric(:,2); %n gold 
k = gold_dielectric(:,3); %k gold 
l = gold_dielectric(:,1); %wavelength 
  
for L = 1:10 
     
    for t = 1:length(n) 
        m = (n(t)+i*k(t))/nm; 
        kn = (2*pi*nm)/(l(t)*10^(-9)); 
        x = kn*r(j); 
        Dn_x = ((L*besselj(L, x))/x - besselj(L + 1,x))/(besselj(L,x)); 

  Dn_mx = ((L*besselj(L, m*x))/(m*x) –  
           besselj(L + 1,m*x))/(besselj(L,m*x)); 

  
a(L,t) = (((Dn_mx/m)+(L/x))*besselj(L,x)-   besselj(L1,x))/(((Dn_mx/m)+(L/x))* 
besselh(L,x)-besselh(L-1,x)); 
 
b(L,t) = (((m*Dn_mx)+(L/x))*besselj(L,x)- 
besselj(L-1,x))/(((m*Dn_mx)+(L/x))*besselh(L,x)-besselh(L-1,x)); 
  
w(t) = l(t); 
  
    end %end t-loop 
     
end %end L-loop 
  
sc_per = (2/x)*((abs(a(1,:))).^2 + 
2*((abs(b(2,:))).^2+(abs(a(2,:))).^2+(abs(b(3,:))).^2+(abs(a(3,:))).^2+(abs(b(4,:))).^2+(ab
s(a(4,:))).^2+(abs(b(5,:))).^2+(abs(a(5,:))).^2+(abs(b(6,:))).^2+(abs(a(6,:))).^2+(abs(b(7,:)
)).^2+(abs(a(7,:))).^2+(abs(b(8,:))).^2+(abs(a(8,:))).^2+(abs(b(9,:))).^2+(abs(a(9,:))).^2+(
abs(b(10,:))).^2+(abs(a(10,:))).^2)); 
 
sc_par = (2/x)*((abs(b(1,:))).^2 + 
2*((abs(b(2,:))).^2+(abs(a(2,:))).^2+(abs(b(3,:))).^2+(abs(a(3,:))).^2+(abs(b(4,:))).^2+(ab
s(a(4,:))).^2+(abs(b(5,:))).^2+(abs(a(5,:))).^2+(abs(b(6,:))).^2+(abs(a(6,:))).^2+(abs(b(7,:)
)).^2+(abs(a(7,:))).^2+(abs(b(8,:))).^2+(abs(a(8,:))).^2+(abs(b(9,:))).^2+(abs(a(9,:))).^2+(
abs(b(10,:))).^2+(abs(a(10,:))).^2)); 
 

 

 


